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Introduction

The following comprehensive build document includes all required steps to build a KwikTag
system. This includes step by step instructions to install the operating system, OS/KwikTag
dependencies, KwikTag software, scanners, etc. There is also an advanced section for
troubleshooting and configuration. The intention of this document is provide all the
necessary information to successfully install KwikTag by following through the entire
document, section by section.

However, section 1 is a minimum requirements checklist, outlining the basic configuration
required for KwikTag to function properly. Any existing server or standard build must meet
the minimum requirements outlined in section 1 to be a supported KwikTag configuration.
For new builds, it is recommended to follow the step by step build instructions (starting in
section 2) to ensure a successful, supported KwikTag installation.

Installations on 64-bit operating systems, SQL server clusters, Domain
Controllers, and Microsoft Small Business Server are not supported.

The complete build instructions start in section 2. The high level steps are as follows:

- Install Operating System
- Install/configure IIS

- Install SQL Server

- Install Prerequisites

- Install KwikTag

- Post Install Configuration
- Install KwikTag Options
- Configure Input Devices

1 KwikTag Minimum Server Requirements

The following requirements are offered for an existing server or cases where the
detailed build instructions cannot be followed. These are the minimum configuration
settings required for KwikTag to function on Windows Server 2003 (32-bit only).

Installations on 64-bit operating systems, SQL server clusters, Domain
Controllers, and Microsoft Small Business Server are not supported.

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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1.1 Windows Server 2003

Installations on 64-bit operating systems, Domain Controllers, and Microsoft
Small Business Server are not supported.

These are the minimum configuration settings required for KwikTag to function on
Windows Server 2003. For detailed instructions for installing and configuring a
Windows Server 2003 machine please refer to the following sections:

Section 13.1 - Windows Server 2003 OS Installation

Section 13.2 - Internet Information Services 6.0 Setup
Section 14.1 - Installing and Configuring Microsoft SQL Server
Section 15 - Installing KwikTag Prerequisites

Minimum required windows services

KwikTag works with default Windows installed services.
Com + Event System

Com + System Application

Cryptographic Services

DHCP Client

Distributed File System

Distributed Transaction Coordinator

DNS Client

Error Reporting Service

Event Log

FTP Publishing Service (only if using FTP scan device)
HTTP SSL (IIS dependency)

IIS Admin Service (installed by IIS)

All KwikTag Services (installed by KwikTag)
Logical Disk Manager

MSSQLSERVER (installed by SQL 2000)
Net Logon

Network Connections

Network Location Awareness (NLA)
NS$KwikTag (installed by KwikTag)

NTLM Security Support Provider

Plug and Play

Protected Storage

Remote Procedure Call (RPC)

Security Accounts Manager

Server

SNMP

SQLSERVERAGENT (installed by SQL 2000)
System Event Notification

Task Scheduler

TCP/IP NetBIOS Helper

Terminal Services

Windows Management Instrumentation
Windows Time

Workstation

OO000O0O00O000O000O0O0O00O00OO000O000000O00O000000O

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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O World Wide Web Publishing Service (installed by IIS)

Required local accounts for KwikTag
O KwikTag requires a local windows user account that must be added to the local

Administrators group and have “logon as batch job” and “logon as a service”.

The recommended name for this account is ktuser. Verify there is no Domain or
local policy that overrides these settings.

IUSR_Servername and IWAM_Servername must have “Access this computer from
a network”, “logon locally”, and “logon as a batch job”. Verify there is no Domain
or local policy that overrides these settings. (Note: Both accounts are created
with these rights by default during the IIS installation)

Minimum required file system permissions

KwikTag works with the default Windows Server 2003 installed permissions.
Default Windows 2003 permissions are already more secure than previous default
Windows permissions, but if advanced security is required, see the KwikTag Security
section (16.1) for further security measures.

Internet Information Services 6.0 requirements

Minimum Required IIS Components

O

Application Server [Details]
Application Server Console
ASP.NET
Enable network COM+ access
Internet Information Services (IIS) [Details]
Common Files
FTP (only if using FTP Scan device)
Internet Information Services Manager
World Wide Web Service [Details]

O Active Server Pages

O World Wide Web Service

oooao

ooono

Minimum Required IIS Configuration

a
g

Disable session state
Anonymous access only

SQL Server requirements

NOTE: SQL server clusters are not supported.

O SQL Server 2005 Standard
O Mixed Mode authentication required
O SQL Auth User Account with the following permissions
O Member of the System Administrators Role
O Database Access - master database (public role needed)
O Database Access — model database (public role needed)
O Database Access — msdb database (public role needed)
O Supported SQL Collations
All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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O SQL_Latinl_General_CP1_CI_AS
O Latinl_General _CI_AS
O French_CI_AS

Service Pack Requirements
O Windows Server 2003 Service Pack 2
O SQL Server 2005 Service Pack 2

Microsoft .NET Framework Requirements
O 1.1 Framework (built-in)
O 2.0 Framework

Microsoft Internet Explorer Requirements
O Internet Explorer 7.0

All rights reserved. Company Confidential
Copyright © 1998-2008 ImageTag, Inc.
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2 Required Materials

Windows Server 2003 (32-bit) Standard CD
Windows Server 2003 Service Pack 2

SQL Server 2005 (32-bit) Standard CD
SQL Server 2005 Service Pack 2

KwikTag 3.6 Installation CD

[y iy iy

3 KwikTag Server Configurations

The majority of Digital Filing KwikTag installations are installed as single server
configurations. This document addresses these single server configurations as well as an
installation performed on multiple servers. When selecting a configuration install the
corresponding prerequisites as defined in section 4.

Installations on 64-bit operating systems, SQL server clusters, Domain
Controllers, and Microsoft Small Business Server are not supported.

0 Single Server Configuration (KwikTag Workgroup, Departmental, or Enterprise)
o All features installed on the same server

O Multi Server Configuration — (For Custom configurations)
[Note: Servers can be installed in any combination of the 4 Core features listed
below]

Web/Lib Server

Database Server

DAL Server

Paper Gateway Server

O O O O

When installing in a multi server configuration it is recommended that you install in
the following order:

o Web/Lib Server

o DAL Server

o Paper Gateway Server

o Database Server

You can install in any order, but if you install the Database feature prior to installing
the DAL feature, you should use the “"Bypass installation of SQL Notifications
Service” option in the installation to avoid getting any errors related to modifying
the SQL Notification services databases, and the steps will need to be run manually
later. (Section 17.7)

In KwikTag 3.6 the option to “"Bypass installation of SQL Notifications
Service” is checked by default. If you leave this option checked you will
need to install the notification service instance manually in a post install
configuration step.

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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4 Install Operating System and Applications

0 Windows Server 2003 (section 13.1)

Installations on 64-bit operating systems, Domain Controllers, and
Microsoft Small Business Server are not supported.

0 Install and Configure Internet Information Services 6.0 (Section 13.2)

0 Install and Configure Microsoft SQL Server 2005 Standard (Section 14.1)

NOTE: SQL server clusters are not supported.

o

o

5 Install KwikTag Feature Prerequisites

O Single Server

For a Server 2003 Server:

Installations on 64-bit operating systems, Domain Controllers, and
Microsoft Small Business Server are not supported..

IIS 6.0 (refer to section 13.2 for more detailed steps for installing IIS 6)
Enable ASP .NET

@)

@)

Open Control Panel -> Add Remove Programs -> Windows
Components

Select Application Server and click details

Check the checkbox for ASP.NET and click OK

Apply the changes and reboot if necessary

Install Microsoft .NET Framework 2.0

Install Microsoft Internet Explorer 7.0

SQL Server 2005 Standard (refer to section 14 for more detailed steps for
installing SQL Server)

Installations on 64-bit operating systems, SQL server clusters,
Domain Controllers, and Microsoft Small Business Server are
not supported..

Install SQLXML and SQL Notification Services - SQLXML and SQL
Notification Services are a part of the Microsoft SQL Server
installation package (refer to section 15 for more detailed steps for
installing prerequisites)

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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Q Multi Server

1. Web/Lib Server
o IIS6.0
o Install Microsoft .NET Framework 2.0
o Install Microsoft Internet Explorer 7.0
2. Database Server
o SQL Server 2005 Standard (64-bit SQL is supported if the SQL server is
separate from any other KwikTag servers)
= Installations on SQL server clusters, Domain Controllers, and
Microsoft Small Business Server are not supported.
o Install Microsoft .NET Framework 2.0
Install Microsoft Internet Explorer 7.0
o SQL Server 2005 Standard (refer to section 14 for more detailed steps for
installing SQL Server)
= NOTE: 64-bit SQL server is supported if the SQL server is
separate from any other KwikTag server. SQL server clusters
are not supported.
= Install SQLXML and SQL Notification Services - SQLXML and SQL
Notification Services are a part of the Microsoft SQL Server
installation package (refer to section 15 for more detailed steps for
installing prerequisites)

o

3. DAL Server
IIS 6.0
Install Microsoft .NET Framework 2.0
Install Microsoft Internet Explorer 7.0
Install SQLXML and SQL Notification Services - SQLXML and SQL
Notification Services are a part of the Microsoft SQL Server
installation package (refer to section 15 for more detailed steps for
installing prerequisites)
4. Paper Gateway Server
o IIS6.0
o Install Microsoft .NET Framework 2.0
o Install Microsoft Internet Explorer 7.0
5. Clients
o Install Microsoft Internet Explorer 7.0

O O O O

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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6 KwikTag Digital Filing Server Installation

When installing in a multi server configuration it is recommended that you install in the
following order:

o Web/Lib Server

o DAL Server

o Paper Gateway Server

o Database Server

You can install in any order, but if you install the Database feature prior to installing the
DAL feature, you should use the “"Bypass installation of SQL Notifications Service”
option in the installation to avoid getting any errors related to modifying the SQL
Notification services databases, and the steps will need to be run manually later.

In KwikTag 3.6 the option to “"Bypass installation of SQL Notifications Service”

is checked by default. If you leave this option checked you will need to install
the notification service instance manually in a post install configuration step.

ii& KwikTag Enterprise Digital Filing 3.6 Setup I =] |

Welcome to the KwikTag
Enterprise Digital Filing 3.6
Installation Wizard

It is strongly recommended that you exit all
Windows programs before running this setup
prograni.

Click Cancel to quit the setup program, then
close any programs you have running. Click
Mext to continue the installation.

WARNING: This program is protected by
copyright law and international treaties.

Unauthorized reproduction or distribution of

_ this program, or any portion of it, may result
in severe civil and criminal penalties, and will
be prosecuted to the maximum extent
possible under law.

Caricel |

¢ Back
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Licenze Agreement

T'ou muzt agree with the license agreement below to proceed.

EWIETAG LICENSE AGREEMENT ﬂ

Copyright 2004-06, ImageTag, Inc., All Righis Reserved
Yersion Dated 3/21/2006

By installing and using the KwikTag Software, you ("Licensee") agree to be
biound by the terms of this License Agreetrent. By contitining to use the FowikTag
Software, Licensee acknowledges a contining obligation to abide by the terms and
cotuditions of this License A greement. ImageTag, Inc. ("Licensotr") and Licenses may
be referred to individually herein as a "Party" and jointly as the "Parties."

1. Definitions
=
| accept the license agreement
% | do not accept the license agreement
Bezet ¢ Back st > Caricel
All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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6.1 Company Information Screen

fit KwikTag Enterprise Digital Filing 3.6 Setup I =] |

Company Information

E niter the following information to personalize wour installation.

Full Marne; IDemd

Orgarization: IImageT ag

Custamer Code: I

Inztall K.ew:

Erter pour uger and arganization infarmation along with the provided Customer Code
and Install Key. Caontact EwikT ag Cuztomer Suppart at 1-887-E5AE-117 if you need
azsizhance.

¢ Back | Mest > I Caricel

Full Name: This should be pre-filled and is for informational purposes.

Organization: The name of the Organization using the KwikTag Server, this is also
pre-filled from the Windows Server.

Customer Code: 3 segment alphanumeric code assigned by ImageTag, Inc.

Install Key: 25-digit alphanumeric code assigned by ImageTag, Inc.

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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6.2 Installation Type

fit KwikTag Enterprise Digital Filing 3.6 Setup I =] |

Select Installation Type
Select the desired installation epe.

o

All application features will be installed. This option iz for single
zerver installationz.

EIE]E]E]

™ Custom

&

I1ze thiz option to chooze which application features you want
inztalled and where they will be installed. Recommended For
rulti-zerver installations.

OIEICIE]

¢ Back | Mest > I Caricel

» For an installation on a single server run the Complete Install

» For an installation on multiple servers run the Custom Install and install the features
on their corresponding boxes. For example in a dual server configuration install the
Web/Lib Server, Database Server, DAL Server, and Admin Client features on one box
and install only the Paper Gateway Server feature on another box.

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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6.3 Select Feature

fizt Kwik Tag Enterprise Digital Filing 3.6 Setup I =] |

Select Features

Pleaze zelect which features you would like to install

D atabaze Server
Paper Gateway Server
“Wieb Server

Famik.T ag Chents

Feature Description:
Thiz feature will remain uninztalled. T hiz feature requirez OEB on your hard drive.

Digk. Cogt Bezet ¢ Back | Mest > I Caricel
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6.4 Destination Folders

fizt Kwik Tag Enterprise Digital Filing 3.6 Setup I =] |

Destination Folder

Dezignate the locations far the FawikT ag application.

|2 =

— Destination Faolder

C:\Program FilezhkwikT agh, Browse

— Documents and D ata Files

Lkl Tagh Browse

— Komik T ag &pplication Logz
D4 Liogzh, Browse

— kawik T ag Databasze Backup

D:hKwik T ag_B ackup' Browse
— Kok T ag Audit
LAkl T ag_dwadit’, Browse

gLl

Caricel

¢ Back

Verify the destination folders listed on this screen. KwikTag supports various drive
configurations, but defaults to C:\ for Program files and the drive with the most
available space for Data and Configuration files.

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
Copyright © 1998-2008 ImageTag, Inc. page 18 of 122

-



KwikTag Server Installation Process

-

6.5 Customize Setup Screen

fit KwikTag Enterprise Digital Filing 3.6 Setup I =] |

. Customize Setup
The following information iz used by KawikT ag Enterprize Digital Filing

[™ Configure POF account for email capture j’J
[ Specify a user account for anonymous access j’J
¥ Bypass installation of SEL Motifications Service j’J

Selecting any of the itemz above will create additional zteps in the installation proceszs. These steps
are optional and may be performed manually later. Click the help icon nest o an option for a detailed
description.

¢ Back | Mest > I Caricel

Configure POP Account for E-mail Capture: This option will enable the dialogs

for configuring a POP Account during installation. The account is required to capture
images sent from scan-to-email devices such as digital copiers. A KwikTag Service

will monitor the account for incoming images and send them to the Paper Gateway

for processing.

Specify a user account for anonymous access: This option, when selected, will
allow the user to specify an account to use for Com Plus Roles in place of the IUSR
account. Use this option if you are using an account other than IUSR in IIS for
Anonymous Access for the KwikTag Website. This option will be disabled when
installing on a Windows 2000 Server, or if the user is not installing a feature that can
use this functionality.

Bypass installation of SQL Notifications Service: This option will bypass the
setup of the KwikTag SQL Notifications Service during installation. Use this option
only if you have specific requirements to change the parameters of the SQL
Notifications install. In this case the installation program will copy the required files
locally to run manually after the installation.

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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6.6 Service Account Information Screen

fit KwikTag Enterprise Digital Filing 3.6 Setup I =] |

Service Account Information

The following infarmation iz used for kawikT ag related Component
[Carm+] and Windows Services

Izer Mame: || Browse. .. |

Paszwaord: |

Specify an Adminigtrative Accaunt with privileges to this machineg to roun Companent [Com+]
and YWindows Services. This may be a lozal or domain account. Enter in the form:

domainskwiktaguzer or serverikwikiaguzer

¢ Back | Mest > I Caricel

User Name: The account that will run all KwikTag services and Com+ Packages. It
may be a local or domain account, but it must have local admin rights. Standard:
servername\ktuser, the account must be entered with the server name (local) or
domain name (domain) before the account name. (i.e. KwikTag\Administrator)

Password: The password for the user account.

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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6.7 KwikTag Web Site Information Screen

i'g!,'l KwikTag Enterprise Digital Filing 3.6 Setup

KwikT ag Web Site Information
Define a new Microzoft [15 YWeb zite,

& A

_
(- 0

Wweb Site Settings

Deszcrption Il(wikT ag TCP Part IED
II:I

S5L Port

IP Address | |

¢ Back | Mest > I Caricel

IP Address: The IP address to be assighed to the KwikTag website.

NOTE: If you plan to use windows authentication and the server has
multiple IP Addresses and web sites, the IP address used for the KwikTag
website MUST resolve to the NETBIOS name of the server in order for
windows authentication to work.

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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6.8 SQL Server Connection Screen

fit KwikTag Enterprise Digital Filing 3.6 Setup I =] |

SAL Server Connection
Select the SOL zerver and security credentials to be used for SOL
- zonipt execution during installation.

S503L Server Hame:

[
S53L Server Port:
{1433

D atabasze Authentication:

SOL User Mame: I

SOL Pagzward: I

Famik T ag D atabase: IKwikT ag

¢ Back | Mest > I Caricel

SQL Server Name: The name of the Server that the KwikTag database will be
installed on. Microsoft SQL Server must be running on the KwikTag Database Server.

SQL Server Port: The port number that SQL Server is running on. By default this is
1433.

SQL User name: The standard sa account can be used, but this may be any SQL
account with enough rights to access and run all components in the KwikTag
database.

SQL Password: The password for the SQL user account.

Database Name: The name of the database to be used for the KwikTag application.
Standard is KwikTag, but may be any supported SQL name.

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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6.9 Configuration Screen

fit KwikTag Enterprise Digital Filing 3.6 Setup I =] |

Configuration

Information for configuring EwikT ag's Maotification and WerT ag Services.

SMTP Server: ||

Adrmin Ernail Address: |

Ewport Server; |

eCover Destination: |

Provide the SMTF server name relaving messages from the KwikTag Server.

System generated e-mailz come from the Kwik T ag Administrator, enter an appropnate email
address.

Enter the name of the KwikT ag Server as the Export Server for zingle server ingtalls; enter location
of DAL far rmulti-zerver inztalls.

eCovers act ag cover sheetz and when printed shaw the uzer the fax number, or e-mail addrezs to
zend their documents [0 ptional).

¢ Back | Mest > I Caricel

SMTP Server: Enter the DNS name that will be used to send KwikTag system e-
mails.

Admin Email Address: Enter the email address to be used for the KwikTag
Administrator account. This address will be the used for the default From address for
all email notifications.

Export Server: In a multi-server config this is the server with the DAL feature
installed, in a single server config it is the KwikTag Server.

eCover Destination: This is the phone number, or email address that will be
displayed on e-Cover sheets. This is an optional field and, if left blank no phone
number or email address will be displayed on e-Cover sheets.
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6.10 POP Account for Email Capture Configuration Screen
& A

i'g!,'l KwikTag Enterprise Digital Filing 3.6 Setup
POP Account for Email Capture Configuration
|nformation for configuring the Yindows Service.
)
. sl

b ailbox M ame: ||

b ailbox Pazswaord: |

Confirm Paszword: |

POF Server: |

Thiz ‘Windows Service will moritor a POP Server for incoming meszages with TIFF attachments
destined far the KwikTag Paper Gateway. Provide the POP Server and mailbox [Uzer's] name
along with the pazsword.

Configuring Paper Gateway Services during setup iz optional and may be performed later.

¢ Back | Mest > I Caricel

Mailbox Name: Enter the name of the mailbox to be monitored for the Email Input
Service.

Mailbox Password: Enter the password for the mailbox above.

Confirm Password: The password entered in the Confirm Password dialog will be
compared to the previous field to verify that they match. The Next button will not
become enabled until the fields match and the user Tabs out of the Confirm
Password field.

POP Server: Enter the name of the POP server where the mailbox exists.

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
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6.11 Anonymous User Account Information Screen

fit KwikTag Enterprise Digital Filing 3.6 Setup I =] |

Anonymous User Account Information

The following logon information is used for Kawik T ag related

_ Companent [Com+] Service creatar awner rales.
IJzer Mame: || Browse. .. |

Paszwaord: |

Specify a windows account that iz used for anonumous access in 15, Enter in the farm;

domainkwiktaguzer or serverskwikbaguzer

¢ Back | Mest > I Caricel

User Name: This is the account that is specified to be used with Anonymous access
in IIS. This should only be used if you are not using the default IUSR account for
Anonymous access and have already changed the settings in IIS.

Password: The password for the user account.
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6.12 Beginning the Install

fit KwikTag Enterprise Digital Filing 3.6 Setup I =] |

Ready to Install the Application

k]

- i

Click Mest to begin installation, or click the Back button o reenter the ingtallation
information. Click Cancel o exit the wizard.

Caricel |

i'g!,'l KwikTag Enterprise Digital Filing 3.6 Setup |

Updating System

The features you zelected are currently being inztalled.
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6.13 Completed Installation

i'-.% KwikTag Enterprise Digital Filing 3.6 Setup M= |

KwikTag Enterprise Digital Filing
3.6 has been successfully
installed.

Click the Finish button to exit this installation.

Canzel |

NOTE: After installing KwikTag you will be prompted to reboot.
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7 Post-install Configuration

7.1 Single Server

NOTE: If you have installed the 2.0 or later Microsoft .NET Framework, you will need to
verify that the KwikTag Website and the KwikTagWS application directory are set to use
the 1.1.4322 framework. This can be changed in the ASP.NET tab in the properties of
the website and the application:

KwikTag Properties 2lx|
Web Site I Performance I ISAPT Filters I Home Direckory Docurnents |
Directory Security I HTTP Headers I Custam Errors ASP.MET

A5F MET wersion:

Wirtual path: I KwikTag [Select th
File location: I Ci\Program Files\KwikTag)'Websiteiweb, config
File creation date: I Date not available.
File: last modified: I Date not available.
Edit Glebal Configuration, .. | Edit Configuration, . . |

Ok I Cancel | Apply | Help |

ASP.NET Tab

Also, you will need to change the ASP Script timeout to 180 seconds for the KwikTag
website. This can be found in the Home Directory > Configuration > Options tab in the
KwikTag website properties.

1. Setting up your Global Settings

a.
b.
C.

d.

Double click the KwikTag Admin Client icon on your desktop
2Click Tools/Global Settings

Web Settings

i Add the IP or the name of your KwikTag Web Server
Paper Gateway Information

! Logon as Administrator with the default password
2 Whenever you make a change to this panel you MUST click Apply for the changes to

persist
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i Add the path to your import folder. It is recommended that you use a
UNC path; however a local path can be used as well. The user account that is
running the com+ packages should be given full control to this share.

ii. Add the path to your desired input folder such as devicel, or another
input folder of your choice. It is recommended that you use a UNC path;
however a local path can be used as well. The user account that is running
the com+ packages should be given full control to this share.

e. File Repositories

i Click [New]

ii. Click [Browse]

iii. You can use any directory you want for your repository, however it is
recommended that you use the D:\kwiktag\repository directory provided.

iv. Set the Max Size and Next Vol. Size

V. [Ok]

vi. [Apply]

2. Install additional user licenses or options - if required

a. Obtain an updated customer code and install key

b. Run the KwikTag License Utility

Apply latest KwikTag Service Pack or hot fixes available at time of install

Internet Explorer Settings (Optional, but helps aid troubleshooting)

a. Open Internet Explorer

b. Tools/Internet Options

c. Click the Advanced Tab

d. Uncheck the checkbox for “Show friendly HTTP error messages” (Under Browsing)

e. [Apply]

f. [OK]

5. Edit the error_email.txt file located in C:\Program Files\KwikTag\Website. Change
the email address to the email address of the KwikTag system administrator.

6. Change the KwikTag Paper Gateway com+ package activation from server to library

7. Set the failure recovery options for the KwikTag 3.6 Job Service to ‘Restart the
Service’

Hw
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7.2 Multi Server Configuration
Notes:

When Installing Kwiktag in a Multi Server configuration all Servers must have a local ktUser
account (or other standard account) with the same password to run Com+ packages.

This section details the required steps for each Server when installed standalone. If more
than one feature is installed on any Server there are two issues to address.
a. Do not perform the same step more than once if it exists in multiple
features being installed on a single Server
b. Do not Create/Install Proxies for features that are installed on the
same Server (i.e. if Web/Lib and DAL are installed on the same Server
there is no need to install the DAL Proxy on the same Server for
Web/Lib to function because the Com+ Package is locally installed)

7.2.1 Web/Lib Server

NOTE: If you have installed the 2.0 or later Microsoft .NET Framework, you will need to
verify that the KwikTag Website and the KwikTagWS application directory are set to use
the 1.1.4322 framework. This can be changed in the ASP.NET tab in the properties of
the website and the application:

KwikTag Properties 2lx|
Web Site I Performance I ISAPI Filters I Home Direckory Docurnents |
Directory Security HTTP Headers I Custam Errors ASP.MET

ASPnet

ASP.MET wersian:

Wirtual path: I KwikTag [Select th
File location: I Ci\Program Files\KwikTag)'Websiteiweb, config
File: creation date: I Dake not available,
File: last modified: I Dake not available,
Edit Glebal Configuration, .. | Edit Configuration, . . |

ITI Cancel | Hpply | Help |

ASP.NET Tab

Also, you will need to change the ASP Script timeout to 180 seconds for the KwikTag
website. This can be found in the Home Directory > Configuration > Options tab in the
KwikTag website properties.
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1. Create Web-Lib Proxy (To be installed on the DAL and PG Servers) - Refer to section
17 for a detailed explanation on creating com+ proxies

2. Install

3. Install

4.
a.
b.
C.
d.
e.
f.

DAL Proxy (From DAL Server)
DBFinder Proxy (From DAL Server)

Setting up your Global Settings

3Double click the KwikTag Admin Client icon on your desktop
Click Tools/Security
“Click Tools/Global Settings
Web Settings

i. Add the IP or localhost name of your KwikTag Web Server
Paper Gateway Information

i. Add the path to your import folder. It is recommended that you use a
UNC path; however a local path can be used as well. The user account
that is running the com+ packages should be given full control to this
share.

ii. Add the path to your desired input folder such as devicel, or another
input folder of your choice. It is recommended that you use a UNC
path; however a local path can be used as well. The user account that
is running the com+ packages should be given full control to this
share.

File Repositories

i. Click [New]

ii. Click [Browse]

iii. You can use any directory you want for your repository, however it is
recommended that you use a UNC to a share where user account that
is running the com+ packages has full control and no one else has any

access
iv. Set the Max Size and Next Vol. Size
v. [Ok]
vi. [Apply]

5. Apply latest KwikTag Service Pack or hot fixes available at time of install
6. Internet Explorer Settings (Optional, but helps aid troubleshooting)

a.
b.
C.
d

e.

f.
7. Editth

Open Internet Explorer

Tools/Internet Options

Click the Advanced Tab

Uncheck the checkbox for “Show friendly HTTP error messages” (Under
Browsing)

[Apply]

[Ok]

e error_email.txt file located in C:\Program Files\KwikTag\Website. Change

the email address to the email address of the KwikTag system administrator.

3 Logon as Administrator with the default password
* Whenever you make a change to this panel you MUST click Apply for the changes to

persist
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7.2.2
1,

W

5.

7.2.3
1.

ouhwnN

DAL Server

Create the DAL Proxy (To be installed on Web-Lib and PG Servers) - Refer to section
17 for a detailed explanation on creating com+ proxies
Create the DBFinder Proxy (To be installed on Web-Lib and PG Servers) - Refer to
section 17 for a detailed explanation on creating com+ proxies
Install Web Lib Proxy (From Web-Lib Server)
Install additional user licenses or options - if required
a. Obtain an updated customer code and install key
b. Run the KwikTag License Utility
Apply latest KwikTag Service Pack or hot fixes available at time of install

PG Server

Configure the Paper Gateway & Paper Gateway Services as needed
a. If the DAL Server and Paper Gateway Server are on different machines, make
sure all the Sourcename.xml log directories point to a directory that exists on
both systems
Install DAL Proxy (From DAL Server)
Install DBFinder Proxy (From DAL Server)
Install Web Lib Proxy (From Web-Lib Server)
Apply latest KwikTag Service Pack or hot fixes available at time of install
Internet Explorer Settings
a. Open Internet Explorer
b. Tools/Internet Options
c. Click the Advanced Tab
d. Uncheck the checkbox for “Show friendly HTTP error messages” (Under

Browsing)
e. [Apply]
f. [Ok]

Change the KwikTag Paper Gateway com+ package activation from server to library
Set the failure recovery options for the KwikTag 3.6 Job Service to ‘Restart the
Service’

7.2.4 Database Server

1.

Apply latest KwikTag Service Pack or hot fixes available at time of install
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8 Configuring KwikTag Services
8.1 Email Input Service

<data>
<row>
<service>
<servicedata>
<row>
<interval>10</interval>
<sourcelocation>D:\KwikTag\email</sourcelocation>
<mail>
<maildata>
<row>
<sourcename>EMAIL</sourcename>
<mailbox>myKwikTag</mailbox>
<password>emailpassword</password>
<server>mail .mycompany.com</server>
<joblocation>D:\KwikTag\Jobs</joblocation>
<maxbatch>25</maxbatch>
</row>
</maildata>
</mail>
</row>
</servicedata>
</service>
<trace>
<tracedata>
<row>
<traceid>EmailInput</traceid>
<loglevel>0</loglevel>
<logtype>0</logtype>
<loglocation>D:\Logs\EmailInput</loglocation>
</row>
</tracedata>
</trace>
</row>
</data>

Configuration Settings:
Interval - The interval, in seconds, between processing jobs.
Sourcelocation - The location on the file system to “pull” the images from.

Mailbox - The email account name for the service to check. This account must be POP3
enabled.

Password - The password for the email account the service is using.

Server - The server the service uses to check the e-mail account. For example,
mail.mycompany.com. The mail server must be POP3 enabled.
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Maxbatch - The maximum number of e-mails to process at a time.
Traceid - A unique name used when writing data to a log file
Loglevel - Controls if active logging is turned on or off. The default is 0 (off).

Logtype - Controls where data is logged. Valid entries for this setting are 0 (write to
application event log) or 1 (log to file). The default is 0 (write to application event log).

Loglocation - The location on the file system for the service to write logs to when the
logtype is set to 1.

Traceid and logging settings should only be modified to aid in troubleshooting issues with
the service.

8.1.1 Configuring multiple email accounts

To configure the Email Input Capture Provider to check multiple email accounts you will
need to add another row in the maildata element. This is what it would look like:

<maildata>
<row>
<sourcename>EMAIL</sourcename>
<mailbox>myKwikTag</mailbox>
<password>emailpassword</password>
<server>mail .mycompany.com</server>
<joblocation>D:\KwikTag\Jobs</joblocation>
<maxbatch>25</maxbatch>
</row>
<row>
<sourcename>EMAIL</sourcename>
<mailbox>myKwikTag2</mailbox>
<password>emailpassword</password>
<server>mail .mycompany.com</server>
<joblocation>D: \KwikTag\Jobs</joblocation>
<maxbatch>25</maxbatch>
</row>
</maildata>

The row(s) added appears here in bold. When multiple accounts are specified you will need

to add more directories for the additional accounts. For example we are pulling from two
accounts so there needs to be a D:\kwiktag\email\myKwikTag directory and an
D:\kwiktag\email\myKwikTag2 directory and both would have their own sourcename.xml
files as well as a sourcename.xml that remains in the root directory (D:\kwiktag\email)
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8.2 Folder Input Service

<data>
<row>
<service>
<servicedata>
<row>
<sourcelocation>D:\KwikTag\Input</sourcelocation>
<joblocation>D:\KwikTag\Jobs</joblocation>
<includesubdirectories>Yes</includesubdirectories>
<movefilesonly>No</movefilesonly>
</row>
</servicedata>
</service>
<trace>
<tracedata>
<row>
<traceid>FolderInput</traceid>
<loglevel>0</loglevel>
<logtype>0</logtype>
<loglocation>D:\Logs\FolderInput</loglocation>
</row>
</tracedata>
</trace>
</row>
</data>

Configuration Settings:
Sourcelocation - The location on the file system to “pull” the images from.

Joblocation - The location on the file system to store the images for processing by the Job
service.

Includesubdirectories - Search subdirectores of the Sourcelocation for more images to
process. Valid entries for this setting are T or F (True or False), Yes or No, and 0 or 1 (Off
or On). The defaultis T (True).

If includesubdirectores is used the service will only search subdirectories that are one level
deep. For example, if the sourcelocation is set to D:\KwikTag\Input and

includesubdirectores is set to T the service will search the D:\KwikTag\Input\subfolderl,
but will not search the D:\KwikTag\Input\subfolderl\child directory.

Movefilesonly - Only the images will be moved, nothing else. Valid entries for this setting
are Yes or No, Tor F, and 1 or O.

Traceid - A unique name used when writing data to a log file
Loglevel - Controls if active logging is turned on or off. The default is 0 (off).
Logtype - Controls where data is logged. Valid entries for this setting are 0 (write to

application event log) or 1 (log to file). The default is 0 (write to application event log).
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Loglocation - The location on the file system for the service to write logs to when the
logtype is set to 1.

Traceid and logging settings should only be modified to aid in troubleshooting issues with
the service.
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8.3 Export Service

<?xml version="1.0" encoding="utf-8" ?>

<configuration>
<appSettings>
<!-- This interval is how often the service must run
This number is in minutes. -->

<add key="onDemandInterval" value="1440" />

<!-- The following settings of start time and endTime are
designed to keep the service serving only between these
times
This number is in military-time format hhmm.
If you allow this service to run from 5pm to 6am
you would choose startTime as 1700 and endtime as 0600
-—>
<add key="startTime" value="0900" />
<add key="endTime" value="1800" />

<!-- This is the path where the Portable Respository Template
files are stored
generally it is C:\Program Files\KwikTag\Export\Portable
Repository
change it if the install drive of Kwiktag is other than c:
drive
-—>
<add key="portableRepositoryTemplatePath" value="C:\Program
Files\KwikTag\Export\Portable Repository" />

<!-- The following settings are for Internal Use Only and
are NOT to be modified other than the developers -->
<!-- the OrgId to be used for the Service. This should be
-900. -->
<add key="OrgId" wvalue="-900" />
</appSettings>
</configuration>

Configuration Settings:

onDemandInterval - This is how often the service should check for new export jobs to
run. The default is 1440 minutes (1 day).

startTime - The time (in twenty-four hour format) that the service should start looking for
jobs to process. The default is 0900 hours (9 A.M.).

endTime - The time (in twenty-four hour format) that the service should stop looking for
jobs to process. The default is 1800 hours (6 P.M.).

portableRepositoryTemplatePath - This is the path to the portable repository files. The
default is C:\Program Files\KwikTag\Export\Portable Repository

The export path is setup though the File — Export — Set Location dialog in the KwikTag
Admin Client
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L 4

8.4 Import Input Service

<data>
<row>
<service>
<servicedata>
<row>
<sourcelocation>D:\KwikTag\import</sourcelocation>
<joblocation>D:\KwikTag\Jobs</joblocation>
<includesubdirectories>yes</includesubdirectories>
</row>
</servicedata>
</service>
<trace>
<tracedata>
<row>
<traceid>ImportInput</traceid>
<loglevel>0</loglevel>
<logtype>0</logtype>
<loglocation>D:\Logs\ImportInput</loglocation>
</row>
</tracedata>
</trace>
</row>
</data>
Configuration Settings:

III

Sourcelocation - The location on the file system to “pull” the images from.

Joblocation - The location on the file system to store the images for processing by the Job
service.

Includesubdirectories - Search subdirectores of the Sourcelocation for more images to
process. Valid entries for this setting are T or F (True or False), Yes or No, and 0 or 1 (Off
or On). The defaultis T (True).

If includesubdirectores is used the service will only search subdirectories that are one level
deep. For example, if the sourcelocation is set to D:\KwikTag\import and

includesubdirectores is set to T the service will search the D:\KwikTag\import
\subfolderl, but will not search the D:\KwikTag\import \subfolderl\child directory.

Traceid - A unique name used when writing data to a log file
Loglevel - Controls if active logging is turned on or off. The default is 0 (off).

Logtype - Controls where data is logged. Valid entries for this setting are 0 (write to
application event log) or 1 (log to file). The default is 0 (write to application event log).

Loglocation - The location on the file system for the service to write logs to when the
logtype is set to 1.

Traceid and logging settings should only be modified to aid in troubleshooting issues with

the service.
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8.5 KwikTag 3.6 Job Service

<?xml version="1.0" encoding="utf-8" 2>
<configuration>
<configSections>
<sectionGroup name="applicationSettings"
type="System.Configuration.ApplicationSettingsGroup, System, Version=2.0.0.0,
Culture=neutral, PublicKeyToken=b77a5c561934e089" >
<section
name="ImageTag.KwikTag.JobService.Process.FolderSettings"
type="System.Configuration.ClientSettingsSection, System, Version=2.0.0.0,
Culture=neutral, PublicKeyToken=b77a5c561934e089" requirePermission="false"
/>
<section
name="ImageTag.KwikTag.JobService.Process.KwikTagSettings"
type="System.Configuration.ClientSettingsSection, System, Version=2.0.0.0,
Culture=neutral, PublicKeyToken=b77a5c561934e089" requirePermission="false"
/>
<section name="ImageTag.KwikTag.JobService.Properties.Settings"
type="System.Configuration.ClientSettingsSection, System, Version=2.0.0.0,
Culture=neutral, PublicKeyToken=b77a5c561934e089" requirePermission="false"
/>
<section name="ImageTag.KwikTag.JobService.JobSettings"
type="System.Configuration.ClientSettingsSection, System, Version=2.0.0.0,
Culture=neutral, PublicKeyToken=b77a5c561934e089" requirePermission="false"
/>
</sectionGroup>
</configSections>
<applicationSettings>
<ImageTag.KwikTag.JobService.JobSettings>
<setting name="runIntervalInSeconds" serializeAs="String">
<value>5</value>
</setting>
<setting name="jobPath" serializeAs="String">
<value>D:\KwikTag\Jobs</value>
</setting>
<setting name="inprocessPath" serializeAs="String">
<value>D:\KwikTag\Jobs\Inprocess</value>
</setting>
<setting name="logPath" serializeAs="String">
<value>D:\Logs\JobSvc</value>
</setting>
<setting name="failurePath" serializeAs="String">
<value>D:\KwikTag\Jobs\Failure</value>
</setting>
<setting name="tempFolderPath" serializeAs="String">
<value>D:\KwikTag\Jobs\Temp</value>
</setting>
<setting name="serviceName" serializeAs="String">
<value>KwikTag 3.6 Job Service</value>
</setting>
<setting name="idleWaitSeconds" serializeAs="String">
<value>5</value>
</setting>
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<setting name="DEFAULT INSTRUCTIONS" serializeAs="String">
<value>DEFAULT instructions.xml</value>

</setting>

<setting name="PGProcessTimeoutInSeconds" serializeAs="String">
<value>600</value>

</setting>

</ImageTag.KwikTag.JobService.JobSettings>
</applicationSettings>
</configuration>

Configuration Settings:

runIntervalInSeconds - This is how frequently the job service should check for new files
to process. The default is 15 seconds.

idleWaitSeconds - The amount of time to wait before pulling another document to
process. The default is 5 seconds.

Note: You will need to change the Paper Gateway Com+ package from a server application
to a library application. Also, you will need to change the failure recovery options for this
service to ‘Restart the Service’
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8.6 Search Index Service (Global Search)

<data>
<row>
<service>
<servicedata>
<row>
<orgid>-900</orgid>
<!-- TIndex Service ID Do Not change unless
running more than one indexing service per database -->

<indexserviceid>1l</indexserviceid>

<!-- Interval time in minutes -->

<interval>5</interval>
<excludesystemdrawers>False</excludesystemdrawers>
<includearchiveddocuments>False</includearchiveddocuments>

<!-- Set to 0 to return all results -->
<maxfilestoretrieve>1000</maxfilestoretrieve>

<!-- Set to 0 to not restrict the search time -->
<timeoutseconds>5</timeoutseconds>

<!-- The indexlocation, loglocation and
enableddebuglogging settings are updated in the database from this config
file. -—>
<!-- FolderPath where the indexed files are
stored -->
<indexlocation>D:\KwikTag\KGSIndex</indexlocation>

<!-- FolderPath where the search uses for tempory storage and debug
log files -->
<loglocation>D:\Logs\KGSLogs</loglocation>

<!-- search and index debug logging -->
<enabledebuglogging>False</enabledebuglogging>

<!-- IndexJob Settings -->
<!-- Set to 0 to compress index on every interval -->
<compressindexinterval type="Days">1</compressindexinterval>
<createrelativepaths>False</createrelativepaths>
<allowconcurrentaccess>True</allowconcurrentaccess>
<indexnumbers>True</indexnumbers>
</row>
</servicedata>
</service>
<trace>
<tracedata>
<row>
<traceid>ImageTag, Inc.</traceid>
<loglevel>0</loglevel>
<logtype>0</logtype>
<loglocation>D:\Logs\SearchIndex</loglocation>
</row>
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</tracedata>
</trace>
</row>
</data>
Configuration Settings:

Inteval - The time, in minutes, between processing jobs. The default setting is five
minutes.

Excludesystemdrawers - Exclude system drawers from global searches. Valid entries for
this setting are True or False. The default setting is False.

Includearchiveddocuments - Include documents marked for archivel in global sarches.
Valid entries for this setting are True or False. The default setting is False.

Maxfilestoretrieve - The maximum number of document records to search. The default
setting is 1000.

Indexlocation - The location on the file system where indexed data is stored.
Loglocation - The location on the file system to tempory storeage and debug log files.

Enabledebuglogging - Controls the logging to debug logs to the file system. Valid entries
for this setting are True or False. The default setting is False.

Compressindexinterval - Compress indexed data on every interval. The default setting is
1 Day.

Createrelativepaths -

Allowconcurrentaccess - 9999

Indexnumbers -

Traceid - A unique name used when writing data to a log file

Loglevel - Controls if active logging is turned on or off. The default is 0 (off).

Logtype - Controls where data is logged. Valid entries fOr this setting are 0 (write to
application event log) or 1 (log to file). The default is O (write to application event log).

Loglocation - The location on the file system for the service to write logs to when the
logtype is set to 1.

Traceid and logging settings should only be modified to aid in troubleshooting issues with
the service.
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8.7 Connected Picklist Service

The KwikTag Connected Picklist Service is not installed by default. You can install it later by
using the batch file located in C:\program files\KwikTag\services\ConnectPicklistSvc. When
prompted the username must be entered in the format of server/user or domain/user.

8.7.1 Service Configuration
<?xml version="1.0" encoding="utf-8" 2>
<configuration>

<configSections>

<section name="customSettings"
type="System.Configuration.NameValueSectionHandler"
allowLocation="false"/>
<section name="enterpriselibrary.configurationSettings"
type="System.Configuration.IgnoreSectionHandler, System, Version=1.0.5000.0,
Culture=neutral, PublicKeyToken=b77a5c561934e089" />
</configSections>

<customSettings>
<!-- This interval is how often the picklist service must replace
values in the kwiktag system
This number is in minutes. -->

<add key="onDemandInterval" value="1440" />

<!-- The following settings are for Internal Use Only and
are NOT to be modified other than the developers -->
<!-- the OrgId to be used for the Service. This should be
-900. -->
<add key="OrgId" value="-900" />
</customSettings>

<enterpriselibrary.configurationSettings

xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"

xmlns="http://www.microsoft.com/practices/enterpriselibrary/08-
31-2004/configuration">

<configurationSections>

<configurationSection
name="ImageTag.KwikTag.ConnectedPicklist.Service.Config" encrypt="false">
<storageProvider
xsi:type="XmlFileStorageProviderData" name="XML File Storage Provider"
path="Picklist.config" />
<dataTransformer xsi:type="CustomTransformerData"
name="Custom Transformer Provider"
type="StringSerializer.Configuration.StringTransformer,
StringSerializer.Configuration" />
</configurationSection>

</configurationSections>

<keyAlgorithmStorageProvider xsi:nil="true" />

<includeTypes />

</enterpriselibrary.configurationSettings>

</configuration>
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Configuration Settings:

onDemandInterval - The interval, in minutes, that determines how often the service will
“refresh” the picklist data. The default setting is 1440 minutes (24 hours). It is strongly
recommended that the service is run more frequently than the 24 hour period. The
connected picklist services has been tested to work with up to 20,000 rows.

8.7.2 Picklist.config Configuration

<?xml version="1.0" encoding="utf-16"?2>
<ImageTag.KwikTag.ConnectedPicklist.Service.Config>

<xmlSerializerSection type="ImageTag.KwikTag.Transport.Configuration,
connectedPicklist, Version=1.0.0.0, Culture=neutral, PublicKeyToken=null">

<connectedPicklistService xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"

xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<connectedPicklists>
<connectedPicklist
picklistName="Employees"
oleDBConnectionString="Provider=sqloledb;Data
Source=localhost;Initial Catalog=Northwind;User Id=sa;Password=;"
sglStatement="SELECT LastName + ',' + FirstName AS Exprl FROM
Employees"
/>
<connectedPicklist
picklistName="Books"
oleDBConnectionString="Provider=sqloledb;Data
Source=localhost;Initial Catalog=pubs;User Id=sa;Password=;"
sglStatement="SELECT title FROM titles WHERE (title LIKE
vs%v)u
/>
</connectedPicklists>
</connectedPicklistService>

</xmlSerializerSection>
</ImageTag.KwikTag.ConnectedPicklist.Service.Config>

Configuration Settings:
picklistName - The name of the KwikTag picklist that the data will be added to.

oleDBConnectString - This defines how the service can make a connection to the
database.

sqlStatement - A SQL query to retrieve data from the target database.
NOTES:

Only the first column will be considered for the picklist value and name of the column is of no importance
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IMPORTANT: Whenever the password to connect to another system changes, make sure the config file
is updated, otherwise the service will keep retrying at the interval, which may sometimes lock up the db
account.

8.8 Purge Service

<?xml version="1.0" encoding="utf-8"?>

<configuration>
<appSettings>
<!-- Location on the file system of ktagPurge.exe

This needs to be modified if the Kwiktag is installed on a
drive other than c:
key="PurgeExeLocation" value="c:\Program
Files\KwikTag\purge\ktagPurge.exe" -->
<add key="PurgeExelLocation" value="C:\Program
Files\KwikTag\Purge\ktagPurge.exe" />

<!-- This interval is for the
Base Purge options (Drawer Delete Options in the Admin Client)
This number is in minutes. -->

<add key="onDemandInterval" value="30" />

<!-- The following settings are for Internal Use Only and
are NOT to be modified other than the developers -->
<!-- the OrgId to be used for the Purge. This should be -

900. -->
<add key="OrgId" value="-900" />
</appSettings>
</configuration>

Configuration Settings:

onDemandInterval - The interval, in minutes, that determines how often the service will
run a purge cycle. The default setting is 30 minutes.
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8.9 Retention Service

<?xml version="1.0" encoding="utf-8"?2>

<configuration>
<appSettings>
<!-- This interval is in minutes/hours/days/months

based on archivelIntervalType value -->
<add key="interval" value="7" />

<!-- Valid options are Minutes, Hours, Days, Months for
intervalType -->
<add key="intervalType" value="Days" />

<!-- intervalStartTime must be in Military time of the Server's
timezone -->
<add key="intervalStartTime" value="05:00" />

<!-- The following settings are for Internal Use Only and
are NOT to be modified other then the developers -->

<!-- the OrgId to be used for the Purge. This should be -
900. -->
<add key="OrgId" value="-900" />

<!-- These type ids are outlined in the database. Here,
Archive Type Id = 1 is the
Id you want to use. It is the 'Auto Archive' type

id. If a drawer is set to
delete archive documents, this setting will insure
that they are removed. -->

<add key="archiveTypeId" value="1" />

<!-- This setting allows the Archive type to be rerun, not
just run once as most purge
functions. -->
<add key="rerunArchive" value="true" />

<!-- This is how often the system will check the time on
the first day to determine whether
the Archive should run and then set the
interval to run on that period. -->
<add key="timeCheckInterval" value="1" />

</appSettings>
</configuration>
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Configuration Settings:

Interval - The interval that determines how often the service will run a check on retention
data. The default setting is 7.

Intervaltype - The type of interval to use. Valid settings are Minutes, Hours, Days, and
Months. The default setting is Days.

Intervalstarttime - The time when the service will run the check on retention data based
on a 24:00 hour clock. The default setting is 05:00 (5 am).

Archivetypeid - The type of archive documents to process. The default setting is 1.

Rerunarchive - This setting allows archive purge actions to run multiple times. The
default setting is true.

Timecheckinterval - This is how often the system will check the time, on the first day, to
determine whether the Archive should run and then set the interval to run on that period.
The default setting is 1.

8.10 WebSession Cleaner Service

<?xml version="1.0" encoding="utf-8"?>

<configuration>
<appSettings>
<!-- ServicelInterval is in Minutes -->

<add key="ServicelInterval" value="1" />

<!-- RemoveFilesHoursOld is the number of hours ago
that the files are to be removed.
e.g. 168 hours = 1 week ago, so all files that
are a week old and older will be removed. -->
<add key="RemoveFilesHoursOld" value="168" />

</appSettings>
</configuration>

Configuration Settings:

Serviceinterval - The interval, in minutes, that determines how often the service will run a
check on web session data. The default setting is 1.

Removefilehoursold - Remove web session files that are at least x hours old. The default
setting is 168 hours (7 days).
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8.11 Sourcename.xml

<?xml version="1.0" encoding="IS0-8859-1"?2>
<data>
<row>
<queuetypeid>DocDiscriminator</queuetypeid>
<source>
<sourcedata>
<row>
<sourcename>FOLDER</sourcename>
<deviceserver>Scanner</deviceserver>
<deletesimilarfiles>Yes</deletesimilarfiles>
<timespan>00:00:00</timespan>
</row>
</sourcedata>
</source>
<imageinstr>
<imageinstrdata>
<row>
<ocrautorotate>Yes</ocrautorotate>
<ocrpagedeskew>Yes</ocrpagedeskew>
</row>
</imageinstrdata>
</imageinstr>
<autoindex>
<autoindexdata>
<row>
<username>Administrator</username>
<password></password>
<autoindexinstructions>
<autoindexinstructionsdata>
<row>
<progid>ktagAIDefault.AIDefault</progid>
<autoindexinstruction>
<autoindexinstructiondata>
<row>
<drawer>Lost and Found</drawer>
</row>
</autoindexinstructiondata>
</autoindexinstruction>
</row>
</autoindexinstructionsdata>
</autoindexinstructions>
</row>
</autoindexdata>
</autoindex>
<deliveryinstructions>
<deliveryinstr>
<deliveryinstrdata>
<row>
<queuetypeid>ToKwiktag</queuetypeid>
<deliverydata>
<deliveryprovider>
<deliverytypeid>1</deliverytypeid>
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<name>ToKwiktag</name>
</deliveryprovider>
</deliverydata>
</row>
</deliveryinstrdata>
</deliveryinstr>
</deliveryinstructions>
<barcodesearch>
<barcodesearchdata>
<row>
<symbology>I20F5</symbology>
<thispageonly></thispageonly>
<requirecheckdigit>Y</requirecheckdigit>
<barcodethreshold>20</barcodethreshold>
<!-- spotfilter wvalues: blank for default, O=no filter, 1=1x1
filter, 2=2x1 filter. Most are 1, Oce 3165 uses 2.
-—>
<spotfilter></spotfilter>
<!-- orientation values: blank for default, O=Horizontal only,
1=Vertical only, 2=Horizontal and vertical, 3=Horizontal with significant
skew, 4=Vertical with significant skew, 5=Vertical and horizontal with
significant skew.

-—>
<orientation></orientation>
<!-- quality wvalues: blank for default or 0 thru 10. Zero default,
1 is worst image quality, 10 is best (theoretically). Some guidelines are:

1=FAX input, 10=First generation print, 7=2nd generation copy, 4=Microfilm
scan.
-——>
<quality></quality>
<!-- indepth wvalues: blank for none, 0O=none, 1=Orientation,
2=Quality, 3=Both. WARNING: this parameter reads each page repetitively,
especially when there are really no barcodes on a page.
-—>
<indepth></indepth>
<maxlength>9</maxlength>
<minlength>5</minlength>
</row>
</barcodesearchdata>
</barcodesearch>
<trace>
<tracedata>
<row>
<traceid>KwikTag</traceid>
<loglevel>0</loglevel>
<logtype>0</logtype>
<loglocation>D:\Logs\sourcename logs</loglocation>
</row>
</tracedata>
</trace>
<docdiscriminatorflow>
<docdiscriminatorflowdata>
<row>
<mainflow>
<mainflowdata>
<row>
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<queuetypeid>BCR2</queuetypeid>
</row>
<row>
<queuetypeid>AutoIndex</queuetypeid>
</row>
</mainflowdata>
</mainflow>
<docflow>
<docflowdata>
<row>
<progid>ktagDocLoc.DocLoc</progid>
</row>
<row>
<progid>ktagStandardDoc.StandardDoc</progid>
</row>
<row>
<progid>ktagValidateDoc.ValidateDoc</progid>
</row>
</docflowdata>
</docflow>
<nextstep>1</nextstep>
</row>
</docdiscriminatorflowdata>
</docdiscriminatorflow>
<statistics>
<statisticsdata />
</statistics>
</row>
</data>

Configuration Settings:

Device Server - The name of the Server the device runs on or the name of the device.
This field is purely informational in nature and is optional to modify.

Delete Similar Files - Often scan devices will create a file in addition to the multi-page Tiff
that is required by KwikTag. This option is turned on by default (Yes).

Timespan - This is for long timeouts between jobs. By default this is set to 00:00:00. The
zeros represent Hours, Minutes, and Seconds (going from left to right). This should only be
used if necessary. For example if a customer has to scan various different sizes of paper.
The way this works is the documents are held in the input folder and the job is not
processed until the timespan timeout has been reached. For example if the timespan is set
to 00:02:00, 2 minutes, after the job has been scanned the FolderInputService will wait 2
minutes before taking the job. If more pages are scanned before the 2 minutes is up the
FolderInputService will wait until it reaches the 2 minute timespan timeout.

Ocrautorotate - When ocrautorotate is set to Yes (default), the document will be rotated
based on the orientation of the text. However if you are having issues with pages being
rotated incorrectly, you can try setting this to No.

Ocrpagedeskew - Toggles on or off the deskewing of ocr document that are processed.
This option is turn on by default (Yes).
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Username - This is the name of a KwikTag user account that has permission to index into
the specified autoindex drawer(s). This is set to Administrator by default.

Drawer - This is the drawer where document will be *filied’ into if the system is unable to
read the barcode or find any index instructions for the document(s). By default this is set to
Lost and Found.

Symbology - This is the symbology of the barcode being used such as I120F5 or 30F9.
This option is set to I20F5 by default. The valid symbology entries are:

ALL
30F9
CODABAR
I20F5
A20F5
128

93

20F5
UPCA
UPCE
EAN13
EANS8
POSTNET
PDF417
PATCH
UCC128

Thispageonly - This tells the system to only look for a barcode on the page specified. This
is blank by default. Usage: <thispageonly>7</thispageonly> only look for a barcode on
page 7 of the document.

Requirecheckdigit — Toggles the use of searching for a checkdigit in the barcode.
Typically you would only use this when using manufactured barcodes that were
manufactured without requiring a check digit. This option is set to ‘Y’ by default.

Barcodethreshold - Any documents processed with a threshold below this number will not
be considered a document. This option is set to 20 by default.

Maxlength - This is the longest any valid barcode can be. This option is set to 9 by
default.

Minlength - This is the shortest any valid barcode can be. This option is set to 5 by
default.

Note: Trace Id and Logging settings are optional, and should only be turned on to
troubleshoot issues.

Traceid - A unique id used when logging is active. This is set to KwikTag by default.

Loglevel - Turns logging on and off. By default is this set to 0 (off).
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Logtype - Specifies where to log, to a file or to the event log. This is set to 0 (event log)
by default.

Loglocation - The path to write log files to. By default this is D:\Logs\Sourcename_logs
8.11.1 Specifying a custom autoindex drawer

<autoindexdata>
<row>
<username>Administrator</username>
<password></password>
<autoindexinstructions>
<autoindexinstructionsdata>
<row>
<progid>ktagAIDefault.AIDefault</progid>
<autoindexinstruction>
<autoindexinstructiondata>
<row>
<drawer>Autoindex</drawer>
<retrievaltags>
<retrievaltagsdata>
<row>
<name>Added Field</name>
<value>{BARCODE }</value>
</row>
<row>
<name>Description</name>
<value>{FILENAME }</value>
</row>
</retrievaltagsdata>
</retrievaltags>
</row>
</autoindexinstructiondata>
</autoindexinstruction>
</row>
</autoindexinstructionsdata>
</autoindexinstructions>
</row>
</autoindexdata>

Username - This is the name of a KwikTag user account that has permission to index into
the specified autoindex drawer(s). This is set to Administrator by default.

Drawer - This is the drawer where document will be *filied’ into if the system is unable to
read the barcode or find any index instructions for the document(s). By default this is set to
Lost and Found.

Name - This is the name of the index field in the drawer to use.

Value - This is the value you want for the name (index field) it is paired with. By default
there are 2 reserved values, {BARCODE} and {FILENAME}. Using these will fill the fields
with the value of the Barcode that KwikTag detects on the document or the File hame of the
document before KwikTag started processing it.
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9 KwikTag Options®

9.1 Installing KwikTag Options and User Licenses

1. Obtain an updated customer code and install key
2. Run the KwikTag License Utility

9.2 Import

Note: With the release of KwikTag 3.4 Service Pack 1, Import is now included as part of the
base KwikTag system.

9.2.1 KwikTag Import Utility

1. Run ktagImportUtility.exe
2. Specify a drawer name
3. Select an Input File
4. Select your Output folder
5. Click OK
.3

1.

9.3 Export

Create a Share on the KwikTag Server for the Export Files (Export will only work
when browsing to a Share in the Export interface)

2. Open the Admin client and configure Export to point to that share and verify the
Export service running

9.4 Universal Delivery Provider (UDP)

1. Go to Delivery Settings of a drawer in the Admin Client

2. Select the checkbox for Enable Delivery

3. Browse to a directory the KwikTag Service has access to. This can be either local or
a UNC path to share.

4. Test the connection

5. Apply the successful settings

9.5 Global Search

Note: With the release of KwikTag 3.5, Global Search is now included as part of the base
KwikTag system.

10 Apply KwikTag Updates

o Apply latest System updates or Service Packs®

> These instructions only apply if you are installing KwikTag options not included in the base
system.

® For updates to the KwikTag Server and/or Additional Components please refer to the
corresponding readme file.
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11 Standard Settings for Scanners

Technically KwikTag is scanner agnostic, which is to say that it can use images produced by
any scan device provided it meets the following criteria:

O Outputs a Multi-Page Tiff file

O Outputs using one or more of the following methods:
O Scan to FTP
O Scan to email
O Scan to network repository

The image processing engine can accept an image from any device as long as it is in the
correct format and the density is set light enough for decent barcode recognition. The
following are standard recommend settings for scan devices:

O B&W Text Bi-tonal Multi-Page Tiff

O 300 dpi

O CCIT Group 3 or Group 4 Compression (LZW Compression is not currently
supported)

The following are basic steps for setting up a scan device to output to the KwikTag server
using one of the previously mentioned scanning methods. For specific instructions on
setting up your scan device to work with KwikTag refer to the Input Devices document
included in the documentation section of the installation cd or contact support.

Scan to FTP
To use Scan to FTP functionality the following steps need to be performed:
O Create an FTP virtual directory on the KwikTag Server that points to a
device input folder (refer to section 16.7 for detailed instructions)
O Setup your scan device to output to the FTP virtual directory that was
created on the KwikTag Server
O Scan a test document into KwikTag

Scan to email

To use Scan to email functionality the following steps need to be performed:

O Create a POP3 email address on your mail server (the POP3 and SMTP
protocols need to be enabled on the mail server)

O Setup the KwikTag email service to use the email account that was just
created (refer to the KwikTag 3.5 Service Configuration Guide for detailed
instructions for setting up and using the email service)

O Setup your scan device to send to the email account that was created and
attaching the document to the e-mail

O Scan a test document into KwikTag
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Scan to network repository

To use Scan to network repository functionality the following steps need to be performed:

O Create a share on the KwikTag Server from a folder in the data directory
(For example, share out D:\Input\devicel assuming you installed the data
directories to the D:\ drive)

O Setup your scan device to output to the newly created network share
O Scan a test document into KwikTag
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12 Setting up Windows Authentication for KwikTag
12.1 Windows Authentication for KwikTag : Configuration

NOTE: If your server has multiple IP Addresses and web sites the IP address
used for the KwikTag website MUST resolve to the NETBIOS name of the server
in order for Windows Authentication to work.

1. Change Directory Security for the KwikTag Website and KwikTagWS virtual directory
a. Turn off Anonymous Access
b. Turn on Integrated Windows Authentication
c. Apply changes to the KwikTag Website and all subdirectories
2. Edit Web.config
a. Remove the comments from the <authentication> and <identity> elements
b. Remove the comments from the <allow roles> element
c. Save your changes and close the Web.config. In a typical default installation
this would be located in C:\Program Files\KwikTag\Website\KwikTagWs
3. ’Create the following groups locally. These groups are case sensitive and must
match the case and spelling of the group in KwikTag.
a. KwikTag Logon
b. KwikTag Guests
c. KwikTag Users
d. KwikTag Admins
4. ®Modify the following Com + Packages and roles
a. Change the Identity of the KwikTag Logon Manager Package to run as a
domain user and add that user to the local KwikTag Logon Group.
b. Add KwikTag Logon Group to Creator Owner Com + Role for the following
packages:
i. KwikTag API
ii. ImageTag.KwikTag.API.BLL
iii. KwikTag AppLoader
iv. KwikTag Logon Manager
v. KwikTag Soap
vi. KwikTag WebLib

5. For Users that will access KwikTag, add the appropriate domain group(s) or user(s)
to the local KwikTag groups. All groups or users must be in the local KwikTag Logon
Group and one other local KwikTag Group. The Logon group is required for all groups
and users to allow Logon access, and the additional group is used to define the
permissions in KwikTag.

6. Additional Groups can be created in KwikTag to provide more flexibility for applying
permissions. However, after creating the Group in KwikTag, and applying
permissions for that group, a local Windows Group must be created with the same
name, and the appropriate domain users and groups must be added to this local
Windows Group.

7. Reboot server

7'In a multi-server configuration you would set this up on the Web Server.
8 In a multi-server configuration you may need to uninstall the WebLib Proxy from the DAL
server and re-export and reinstall the proxy.
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NOTE: When Windows Authentication is enabled, it is not recommended that you
logon to your KwikTag Server using KwikTag Authentication. If the logged on User
has the proper permissions on the KwikTag Server, KwikTag Authentication will
work, but the configuration was not designed to support both.

12.2 Windows Authentication for KwikTag : Windows Rights &

Com+ Package Roles

NOTE: Below are the requirements for the Windows User and Groups, and Com+ Packages.
These are not additional steps to perform, but rather a snapshot of what a KwikTag System
with Windows Authentication enabled should look like.

Windows Users and Groups:

1.

2.

Local Administrators Group:
a. ktuser
b. Domain\Domain Admins (group)
Local Users Group:
ktuser
ASPNET
Domain\Domain Users
NT Authority\Authenticated
NT Authority\Interactive

Popow

KwikTag Com+ Packages Identity and Roles:

1.

KwikTag API - Package is run as local ktuser account with the following user
accounts in the creator owner com+ role:

a. Server\IUSR_Server

b. Server\ktuser

c. Server\KwikTag Logon (group)

d. NT Authority\Network Service
KwikTag ApplLoader - Package is run as local ktuser account with the following user
accounts in the creator owner com+ role:

a. Server\IUSR_Server

b. Server\ktuser

c. Server\KwikTag Logon (group)
KwikTag Cryptography - Package is run as local ktuser account with the following
user accounts in the creator owner com+ role:

a. Server\ktuser
KwikTag DAL - Package is run as local ktuser account with the following user
accounts in the creator owner com+ role:

a. Server\IUSR_Server

b. Server\ktuser

c. NT Authority\Anonymous Logon

d. NT Authority\Network Service
KwikTag DBFinder - Package is run as local ktuser account with the following user
accounts in the creator owner com+ role:

a. Server\ktuser

b. NT Authority\Anonymous Logon
KwikTag Flow Manager - Package is run as local ktuser account with the following
user accounts in the creator owner com+ role:
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a. Server\ktuser
7. KwikTag ktagCryptography - Package is run as local ktuser account with the
following user accounts in the creator owner com+ role:
a. Server\ktuser
b. Server\Administrators
8. KwikTag Logon Manager - Package is run as domain user account with the following
user accounts in the creator owner com+ role:
a. Server\ktuser
b. Server\KwikTag Logon (group)
c. NT Authority\Network Service
9. KwikTag Paper Gateway - Package is run as local ktuser account with the following
user accounts in the creator owner com+ role:
a. Server\ktuser
10. KwikTag Soap - Package is run as local ktuser account with the following user
accounts in the creator owner com+ role:
a. Server\IUSR_Server
b. Server\ktuser
c. Server\KwikTag Logon (group)
d. NT Authority\Network Service
11. KwikTag Universal DP - Package is run as local ktuser account with the following user
accounts in the creator owner com+ role:
a. Server\IUSR_Server
b. Server\ktuser
c. NT Authority\Anonymous Logon
d. NT Authority\Network Service
12. KwikTag WeblLib - Package is run as local ktuser account with the following user
accounts in the creator owner com+ role:
Server\Administrators
Server\IUSR_Server
Server\ktuser
Server\KwikTag Logon (group)
NT Authority\Anonymous Logon
NT Authority\Network Service

SO0 oW
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13 Operating System Installation Instructions

These instructions are provided as guidelines and recommendations. If a company
already has a standard build for server documentation verify it meets the minimum
requirements outlined in section 1.

Installations on 64-bit operating systems, Domain Controllers, and Microsoft
Small Business Server are not supported.

13.1

Windows Server 2003

Installations on 64-bit operating systems, Domain Controllers, and Microsoft Small
Business Server are not supported.

13.1.1 Windows Server 2003 Installation
1. Insert Windows Server 2003 disk in CD and power on Server and boot from CD when
the option appears
2. Press Enter to continue
3. Type C to continue— Only applies when a new, ‘clean’ hard drive is used
4. Press F8 to accept license agreement
5. Esc to for a fresh Windows 2003 Server Installation
6. Choose create a partition and enter a size that is approximately 30% of the total
hard drive space (this partition should never be less than 4096 (4 GB))—Press Enter
7. Highlight the C:\ partition and press enter to install Windows Server 2003 on that
partition
8. Highlight NTFS format and press enter
9. Press Enter to Restart—It's not necessary to remove the CD from the CD-Rom Drive,
just don’t press a key when prompted to boot from CD.
10. Click Next
11. Regional Settings, Next
12. Name - Use appropriate naming convention
13. Company - Use appropriate naming convention
14. Licensing Per Server - refer to customer licensing information
15. Server Name - Use appropriate naming convention
16. When prompted for the Admin password use an appropriate password for the Admin
password. I.e. if it's a Regression Server, so you would use the Regression Admin
password.
17.Set Date and Time/Time Zone, clear Daylight Savings box if appropriate
18. Network Settings—Typical Settings
19. Make the computer a Workgroup member.
13.1.2 Windows Server 2003 Configuration
1. Log on as Administrator
2. Manage Your Server
a. Check the checkbox for ‘Do not display this page at logon.’
b. Close the dialogue window
c. Set Resolution to 800x600 or higher (choose appropriate setting for Video
Card and Monitor)
3. Set View to Classic
a. Right Click Task Bar and select Properties
b. Click Start Menu Tab
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Select Classic Start Menu
[Customize]

e. Check the following checkboxes:

i. Display Administrative Tools
ii. Display Log Off
iii. Show Small Icons in Start menu
f. Uncheck the following checkbox:
i. Use Personalized Menus
4. Set IP Address
Right Click My Network Places -> Properties
Right Click Local Area Connection -> Properties
TCP/IP —> Properties
Set IP Address
Set Subnet Mask
Set Gateway
Set DNS
. Apply the settings and close the local area dialogue boxes
5. Join the domain—if applicable®
Right click MY COMPUTER
Properties
Computer Name Tab
[Change]
Select DOMAIN and type {Domain Name}
Enter the Administrator username and password and click OK
[OK]
[OK]
[Yes]
When you come back from the reboot make sure you log into the domain and
NOT the local machine
i. Note: Once you logon as another user you will need to repeat steps 2

&3
6. Administrators Group configuration

a. Right Click on My Computer

b. Select Manage

c. Local Users and Groups\Groups\Administrators. Verify that both the Local
Administrator and Domain Administrator (if applicable) are in the Local
Machines Administrators Group. Close Computer Management.

d. Create a Kwiktag specific user named ktuser and add to the local Admin
group. (Use standard install password or one supplied by the customer) This
account must have full Admin rights because it will run some services and
com+ packages. (Username can vary if customer restrictions do not allow the
name listed here, but there must be an account with Admin level rights to run
Kwiktag specific components)

7. Format D:\ Drive!®

Click on Disk Management
Right-Click on CD-Rom Drive

Select Change Drive Letter

Set to H:

Right Click on Empty Space on Disk0

Qo

SO0 A0 T

SO mhTo a0 oo

Poo oW

° Only join a domain when you are at the site where the KwikTag Server will be installed.
19 You will use all of the remaining Hard Drive space for the D:\ Drive partition.
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f. Select Create Partition
i. Primary NTFS Partition
ii. D:\ Drive
iii. Quick Format
iv. Volume Label: Data
g. Close Computer Management
8. Create the directory D:\Logs
a. Right Click My Computer -> Explore
b. Click on the D:\ Drive on the left menu
c. Click File->New->Folder
d. Name the folder Logs and hit enter
9. Copy the 1386 directory from the Windows Server 2003 CD to D:\
a. Click the + by the H: Drive (on the left menu) to expand the contents menu
b. Right click and hold the 1386 folder and drag it to the D:\ Drive
c. Release the button and select Copy here
10. Set Performance Settings
Right Click My Network Places -> Properties
Right Click Local Area Connection -> Properties
Select File and Printer Sharing for Microsoft Networks -> Properties
Select "Maximize data through put for network applications”
[OK]
[OK]
Close the Network Places Properties Window
Right Click on My Computer -> Properties
Select Advanced Tab
Click on Startup and Recovery and set Timer to 5 Sec.
Uncheck the Automatically reboot checkbox.
Click OK
. Do not restart
Click on Performance Options
i. Visual Effects Tab
1. Select for best performance
2. Apply
ii. Advanced Tab
1. Processor scheduling - Programs
2. Virtual memory - [Change]
a. D: - Custom Size: Enter 2X the memory of the system
(Min and Max)*!
b. C: - Custom Size: Enter 48 (Min and Max)
c. [OK]

ST ARTTT QT 00T

iii. [Ok]
0. Automatic Updates

i. Uncheck ‘Keep my computer up to date...

ii. [Apply]
p. Remote
i. Check ‘Allow users to connect remotely to this computer’
i. [Apply]
iii. [Ok]
iv. Do not reboot

1 This size should not exceed 1024MB
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11. Set the following services to Manual—Start/Programs/Admin. Tools/Services, double

click to get options.

a. Alerter
b. Automatic Updates
c. Computer Browser
d. Distributed Link Tracking Client
e. Print Spooler
f.  Windows Audio
g. Wireless Configuration
12. Reboot

13.1.3 Common Applications, Updates, Windows Components

1.
2.

3.

Install WinZip 7.0 or later—registered license required (Optional)
Run The Register tool located on the installation CD (Copy the REG to the desktop
then run it)
Set Screen Saver
a. Windows Server 2003 Screen Saver
b. 5 Min Timer
c. Password Protected
d. Power Setting
i. Click POWER button and set monitor to never.
Add/Remove Windows Components
a. [Start] -> Control Panel -> Add/Remove Programs
b. Add/Remove Windows Components
C. Select Accessories and Utilities
d. [Details]
i. Uncheck Communications
ii. Select Accessories
iii. [Details]
1) Uncheck Character Map
2) Uncheck Clipboard Viewer
3) [OK]
iv. [Ok]
e. Uncheck Internet Explorer Enhanced Security Configuration
f. Select Management and Monitoring

g. [Details]
i. Check Simple Network Management Protocol
ii. [OK]

h. Uncheck Update Root Certificates

i. [Next]

j. [Finish]

k. [Yes] - if prompted to reboot

13.1.4 Common Configuration

1.

Activate and Register Windows as appropriate
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13.2 Setting up IIS for Windows 2003
13.2.1 IIS 6.0 Installation

1. [Start] -> Control Panel -> Add/Remove Programs
2. Add/Remove Windows Components
3. Select (highlight) Application Server
4. [Details]
a. Check Application Server Console
b. Check ASP .NET
c. Select (highlight) Internet Information Services (IIS)
d. [Details]
i. Check File Transfer Protocol (FTP) Service - only install if you are
using FTP scan devices
ii. Check World Wide Web Service

iii. [Details]
1) Check Active Server Pages
2) [OK]
iv. [Ok]
e. [OK]
5. [Next]
6. [Finish]

7. Close Add/Remove Programs

13.2.2 IIS 6.0 Configuration

1. Web Site Properties Configuration
[Start] -> Administrative Tools -> Internet Services Manager
Delete the Default Website
Restart IIS
Right click Web Sites folder - properties
Web Site Tab
i. Active log format is W3C Extended Log File Format
ii. [Properties]
iii. Check the checkbox for “"Use local time for file naming and rollover”
iv. Log file directory is D:\Logs
V. Click Advanced Tab
vi. Check all the checkboxes
vii. [OK]
f. Home Directory Tab
i. Uncheck “Index this resource”
ii. Check the checkbox for "Read”
iii. Execute Permissions should be Scripts only
iv. [Configuration]
1) Mappings Tab
a) Remove the following extensions: .idc, .printer, .stm,
.shtm, and .shtml
2) Options Tab
a) Uncheck the checkbox for “Enable session state”
3) [OK]
g. Directory Security

Popow
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i. Click [Edit] in the Anonymous access and authentication control
section
(If customer has security or other configuration requirements that
prevent using IUSR as the anonymous account create an account that
has the same rights/permissions as the IUSR and use this account)

ii. Uncheck the checkbox for “Integrated Windows authentication”

iii. [OK]
h. [Apply]
i. [Ok]
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14 Microsoft SQL Server

64-bit SQL server is supported if the SQL server is separate from any other
KwikTag server. SQL server clusters are not supported.

14.1 SQL Server 2005 Standard Installation

64-bit SQL server is supported if the SQL server is separate from any other
KwikTag server. SQL server clusters are not supported.

1. Select “Server components, tools, Books Online, and samples” from the install
section of the splash screen

SAL Server 2005 (Disc 1 of 2)

Prepare

Review hardware and software requirements
/ Read the release notes

Install SQL Server Upgrade Advisor

Install

Server components, tools, Books Online, and

samples
Run the SQL Mative Client Installation Wizard

Other Information
Browse this CD
Yisit the SQL Server website

§6L Server 2005 Read the SQL Server license agreement
Standard Edition Exit
SQL Server 2005 Startup Splash Screen
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2. Read and accept the end user license agreement and click next

P Microsoft SOL Server 2005 Setup ﬂ

End Uszer Licenze Agreement

MICROSOFT SOFTWARE LICENSE TEEMS ﬂ

MICROSOFT S0QL SERVER 2005 STANDARD AND ENTERPRISE
EDITIONS

These license terms are an agreensht between
Microsoft Corporation (or based on where you
live, one of it=s affiliates) and wvou. Flease
read them. They apply to the =oftware named
abowve, which includes the media on which vou
received i1t, i1f any. The term=s also apply to any
Micro=soft

* ypdates,
* =upplements,

*¥ Internet-ba=s=ed =ervice=s. and

* =zupport services v|

[ i accept the licensing terms and conditions

Print | et = I Cancel |

End User License Agreement

3. Install SQL Server 2005 prerequisites

P Microsoft SOL Server 2005 Setup 5[

Installing Prerequisites

Installz: zoftware components required prior ta instaling SGL
Server

SOL Server Cornponent Update will install the following components ;|
required for SOL Server Setup:

MET Frarneswork 2.0
Microsoft SOL Mative Client
Microsoft SOL Server 2005 Setup Support Files

Click Install to continue,

Click “Install” to begin the installation of the prerequisites
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P Microsoft SOL Server 2005 Setup 5[

Inztalling Prerequisites

Installz: zoftware components required prior ta instaling SGL
Server.

SOL Server Cornponent Update will install the following components ;|
required for SOL Server Setup:

¥ MWET Framewark 2.0
¥ Microsoft SOL Mative Clent
¥ Microsoft SOL Server 2005 Setup Support Files

The required cormponents were instaled successully.

Lance| |

Click “Next” when prerequisite installation is finished to continue

]inzl Microsoft SOL Seryer 2005 Setup ﬂ

» Welcome to the Microsoft SQL
Server Installation Wizard

Setup will help vou install, modify or remove Microsoft
SOL Server. To continue, chick Mest.

< Back | Cancel |

SQL Server Installation Wizard Welcome Screen - Click Next
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4. The results of the system check the installation performed

earlier are displayed on

the “System Configuration Check” dialog screen. If any errors or warnings are

discovered address them before continuing the installation

]inil Microsoft SQL Seryver 2005 Setup ﬂ

System Configuration Check

“Wait while the system is checked for patential installation

problems.

.
@ 14 Tatal 0 Ermor
Success 14 Success 0 waming
Details:
_I Action | Status Message |;|
@ 5 Feature Requiremernt Success
@  Pending Reboot Requirement Success
@ Performance Monitar Counter Require... | Success
@ Default Installation Path Permizzion Re...  Success
@ Intemet Explorer Requirement Success
@ COM Plus Catalog Requirement Success
@ ASP.MNetWersion Registration Require... | Success
@ Minimum MDAC Yersion Bequirement Success
-
Filter - | Stop Beport =
Help |

System Configuration Check Screen
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5. Name: Use appropriate naming convention
6. Company: Use appropriate nhaming convention
7. CD Key: Insert Customer CD Key here

ii;‘!r" Microsoft SOL Server 2005 Setup

Registration Information
The following inFarmation will personalize wour inskallation,

The Mame Figld must be Filled in prior to praceeding. The Company Field is optional.

Marme:!

Company:

|Imau;|eTagJ Inc,

Please enter wour 25 character Product Kew. You can find this number on the welow
ckicker in the CD liner notes or the CO sleeve,

Help | = Back: I [ext = I Cancel

Registration Information Screen

8. Select the following components to install:
O SQL Server Database Services
O Notification Services

O Workstation components, Books Online, and development tools

9. Click advanced to display the Features and Sub Features

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008

Copyright © 1998-2008 ImageTag, Inc.

page 69 of 122

-



KwikTag Server Installation Process

-

i'g!;'- Microsoft SOL Server 2005 Setup 5'

Components to Install
Select the components toinstall or upgrade.

¥ S0L Server Dakabase Services

[T Greate a 500 Server Faflover cluster

[T analysis Services

[T Ereate am dnalysis Server Failover cluster

[~ Reporting Services

v Motification Services

[~ Integration Services

v Aorkstation components, Books Online and development tools:

For more options, click Advanced.

Advanced |

Help |

< Back

| Mext = I

Cancel |

ii|1_!;1' Microsoft SOL Server 2005 Setup

Components to Install Screen

Feature Selection
Select the program Features wou want installed,

X

Click. an icon in the Following lisk ko change how & Feature is installed.

al

Analysis Services
Reporting Services

Maotification Services

Integration Services

Client Components

Documentation, Samples, and Sample [

r—Installation path
Ci\Program FilesiMicrosaft SQL Server),

—Feature description

Installs the SQL Server database
engine and tools For managing
relational and XML data, Replication,
and Full-Text Search.

This Feature requires 251 ME an your
hard drive. It has 4 of 4 subfeatures
selected, The subfeatures require 129
ME on wour hard drive,

Browse.., |

Digk Cosk, .. |

Help |

< Back

I MNexk = I

Cancel |

All rights reserved. Company Confidential
Copyright © 1998-2008 ImageTag, Inc.

Advanced Components Installation Screen

Ver 3.4 - Feb

ruary 27, 2008
page 70 of 122



KwikTag Server Installation Process

10. Expand “Database Services” and select the “Data Files” sub feature
11. Click browse and change the installation path to be on the D:\ drive (or other desired

drive)
12. Click Next
ii-‘%' Microsoft SOL Server 2005 Setup il
Feature Selection
Select the program Features wou want installed,
il
Click. an icon in the Following lisk ko change how a Feature is installed.
- —Feature description
- Database SE“CES Creates the Data Folder in the
Data Files destination shown under Installation
(= ~ | Replication Path.
=3 - | Full-Text Search
(=) ~ | Shared Tools
Analysis Services
Reparting Services
Notification Services This Feature requires 57 MB on wour
Inteqgration Services hard drive.
Client Components
Documentation, Samples, and Sample [
| =
r— Installation path
C3\Program FilesiMicrosoft SQL Server), Browse. .. |
Disk Cosk., .. |
Help | < Back I [ext = I Cancel |
... select the “Data Files” sub feature
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i'-.% Microsoft SOL Server 2005 Setup X

Change Folders
You can seleck a different Folder For installation,

Install in:

I (20 Microsoft SOL Server j L*gl I:..Il

[N
[CAMssaL

Installation path:

:\Program Filesiii

Help | QK I Cancel |

Change Folders Screen

i-.% Microsoft SOL Server 2005 Setup EI

Change Folders
You can select a different Folder For installstion,

Install in:

I (23 Microsoft SQL Server j Igl I:..Il

RS
[CamssoL

Installation path:
|D:'|,Pr|:|gram Files\Microsoft SCL Server!)

Help | [o]4 I Cancel |

...change the installation path to be on the D:\ drive (or other desired drive)
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i‘._w!;'- Microsoft SOL Server 2005 Setup

Feature Selection
Select the program Features you want installed,

x|

Click. an icon in the Following lisk ko change how a feature is installed.

4

. Creates the Data Folder in the
Data Files destination shown under Installation
- = ~ | Replication Path.

(= = | Full-Text Search
= ~ | Shared Tools

- ¥~ | Analysis Services

[]L Reporting Services

[+ =~ | Motification Services This Feature requires 57 MB on wour
- X v | Integration Services hard drive,

-~ =)~ | Clignt Components

- =l = | Documentation, Samples, and Sampls [

l | i

—Feature description——————
B | Database Services P

r Installation path

D:\Program FilesiMicrosoft SOQL Serverd, Browse, ..

Disk Cosk, .

Help | < Back | Mext = I Cancel

Data files sub feature installed to different path

13. Use the default instance name

ii.;% Microsoft SOL Server 2005 Setup

Instance Name

You can install a default instance or vou can specify a named
inskance,

Provide a name for the instance. For a default installation, click Defaulk instance and click
Mext. To upgrade an existing default inskance, click Default instance. To upgrade an existing
named instance select Mamed instance and specify the instance name.

" Mamed inskance

Help | < Back | Mext = I Cancel

Instance Name Screen
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14.Use the “Local System” built-in system account

15. Select the following services to be started at the end of setup:

O SQL Server
O SQL Server Agent
O SQL Browser

i‘._% Microsoft SOL Server 2005 Setup 5[
Service Account
Service accounts define which accounts ko log in,
> |

[~ Customize for each service account

Service:

| 5

¥ Use the built-in Syskem account ILDEal syskem

" Use a domain user acoount

Usermarme: I
Fassword; |
[ormain: I

—Start services at the end of setup
¥ S0l Server

v 30L Server Agent
"

Help | < Back | Mext = I

Cancel

Service Account Screen
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16. Select “"Mixed Mode” authentication mode and enter a password for the ‘SA’ account
x|

Authentication Mode

The authentication mode specifies the security used when
connecking to S0L Server,

Select the authentication mode to use For this installation.

" windows Authentication Mode

¢ mixed Mode (windows Authentication and SQL Server Aukhentication)

Specify the sa logon password below;

Enter password:

I********

Canfirm password:

I********'

Help | < Back I ext = I Cancel |

Authentication Mode Screen

17. Accept the default collation settings (unless installing a specific supported collation)

iié'- Microsoft SOL Server 2005 Setup 5[

Collation Settings
Collation settings define the sorting behavior For your server,

Collation settings For service: SQL Server

" Collation designatar and sort order:

ILatinl_GeneraI j

r Bimary r Binaty - code poink
|_ Zase - sensitive I_ Kana - sensitive
" Accent - sensitive ™ |width - semsitive

[ S0L collations fused For compatibiliby with previous wersians of SOL Server);

Binary order based on code point comparison, For use with the 850 I:Multilingual]d
Strick compatibility with version 1.x case-insensitive databases, for use with the”
Dickionary order, case-sensitive, For use with 1252 Character Set,

Dictionary order, case-insensitive, for use with 1252 Characker Sek, &
' hl_I

Dirlrinnaru nrder . rase-insensitive. nnerrase nreference. For se wirh 1752

Help | < Back | Mext = I Cancel |

Collation Settings Screen

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
Copyright © 1998-2008 ImageTag, Inc. page 75 of 122

-



KwikTag Server Installation Process

i'.‘% Microsoft SQL Server 2005 Setup EI

Collation Settings
Collation settings define the sorting behavior For ywour server,

Collation settings for service: SQL Server

+ Collation designator and sort arder:

ILatinl_GeneraI j

Il Binary r Binary - code poink
[~ Case - sensitive [ Kana - sensitive
[v A [ width - sensitive

{501 collations {used For compatibility with previous versions of SCL Server)

Binary order based on code point comparison, For use with the &30 {Multilingual];l
Strick compabibiity with version 1.x case-insensitive databases, For use with the
Dictionary order, case-sensitive, For use with 1252 Characker Set,

Dirlrinnarv ntder . rase-insensitive, Lnnerrase an.FieanrP.. Frr 11se with 1?!—1?(‘_h|;|
4 3

Help | < Back I ext = I Cancel |

Latinl_General_CI_AS Collation (Non-US English)

ii-‘%' Microsoft SOL Server 2005 Setup EI

Collation Settings
Collation settings define the sarting behaviar For ywour server,

>
Collation settings for service: SQL Server
+ Collation designator and sort order:
Il Binary r Binary - code poink
[~ Case - sensitive [ Kana - sensitive
[V Accent - sensitive [ width - sensitive
{501 collations {used For compatibility with previous versions of SCL Server)
Binary order based on code point comparison, For use with the &30 {Multilingual];l
Strick compabibiity with version 1.x case-insensitive databases, For use with the
Dictionary order, case-sensitive, for use with 1252 Characker Set,
Dirlrinnarv ntder. rase-insensitive. Lnnercase nreference, For nse with 1?!—1?(‘_h|;|
4 3
Help | < Back I [ext = I Cancel |
French_CI_AS Collation (French )
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18. Do not select any of the error and usage reporting settings

i'g!;'- Microsoft SOL Server 2005 Setup 5'

Error and Usage Report Settings

Help Microsoft improve some of the SQL Server 2005 components
and services,

fukomatically send Error reports For SQL Server 2005 ko Microsaoft ar your carporate
Error reporting server, Error reports include information regarding the condition of S0L ¢

[~ Server 2005 when an error occurred, yvour hardware configuration and ather data. Error §
reports may unintentionally include personal information, which will not be used by i
Microsaft.

Automatically send Eeature Usage data For SQL Server 2005 ko Microsaoft, sage data
[ includes anonymous infarmation about your hardware configuration and how you use our
software and services.

For more information on the error reporting Feature and the type of information sent, click
Help.

Help | < Back | Mext = I Cancel

Error and Usage Report Settings Screen

19. Verify the installation settings and complete the installation
x|

Ready to Install
Setup is ready to begin installation.

Setup has enough information to skark copying the program files. To proceed, click Install. To
change any of wour installation settings, click Back, To exit setup, dick Cancel,

The following components will be installed:

. SOL Server Database Services

(Database Services, Replication, Full-Text Search)

. Motification Services

. Client Components

(Connectivity Components, Management Tools, Business Intelligence
Development Studio, SCL Server Books Onling)

Help | < Back I Inskall I Cancel

All rights reserved. Company Confidential Ver 3.4 - February 27, 2008
Copyright © 1998-2008 ImageTag, Inc. page 77 of 122

-



KwikTag Server Installation Process

P Microsoft SQL Server 2005 Setup x|

Setup Progress
The selected components are being configured

il
Produck | Skakus -
MIRMLE
@SOL Setup Support Files Zetup finished
{#)30L Mative Client Configuring components. ..
SOL WSS Writer
OWC1 —
SOL Server Backward-Compatibility Files
SQL Server Database Services
SOLEML4 ﬂ
—atatus
Removing applications
<< Barck | [esk == | Cancel |

¥ Microsoft SOL Server 2005 Setup ﬂ

Setup Progress

The selected components are being configured

il
Product | Skatus |ﬂ
(@ owcit Setup Finished
@SOL Server Backward-Cornpatibility Files  Setup finished
@SQL Server Database Services Setup finished
(0 50LEML4 Setup Finished
@Notiﬁcatiun Services Setup finished
@\-‘isual Studio Integrated Development ... Setup finished
@55 )L Server Books Online Setup finished
@Wurkstatiu:un Cormponents, Books Onlin.,. - Setup finished =
copack  |{THed s Cancel
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F Microsoft SQL Server 2005 Setup 5[

Completing Microsoft SQL Server 2005 Setup
Setup has finished configuration of Microsoft QL Server 2005

Refer to the setup error logs For information describing any Failureds) that occurred during
setup. Click Finish ko exit the installation wizard.

Surmmary Log

To minimize the server surface area of SQL Server 2005, some Features and services are
disabled by default For new installations. To configure the surface area of SOL Server, use the

Surface Area Configuration tool,

Analysiz Services o
+  |fAnalysiz Services was upgraded from SOL Server 2000, all cubes,

ditnenzions, and mining models must be reprocessed uzing SQL Server
kanagement Studio.

Reporting Services

+«  The Reporting Services installation options vou specified in Setup
determine whether further configuration iz required before ywou can
access the repart server. fwou installed the default configuration, the

report server can be used immediately. If vou installed just the program
dilmm rmas vt vraim Hem e midbiinm D mtniimmm (Trmmflmiiemdimin bmm | bm A L dLe j

Hep Fsh |

20. Install SQL Server 2005 Service Pack 2

Microsoft SOL Server 2005 Service Pack 2 Setup

Welcome

Wwelcome to the SGL Server 2005 Service Pack 2 Setup. This ingtallation provides updates
for SAL Server 2005,

Far a list of updates that SOL Server 2005 Service Pack 2 provides, see the Microsoft
knowledoge baze article:

hitp:# #zupport. microsoft comd Mk bid=921 896

To continue, click Next.

<< Back |

Cahicel

SQL Server 2005 Service Pack 2 Welcome Screen
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Microsoft SQL Server 2005 Service Pack 2 Setup

License Terms

Important: 'ou must accept the enclozed License Terms before pou can use this product. If
you do not accept the terms of the Licensze Terms, you are not authorized to uze this
product ahd should return the praduct to wour place of purchaze.

MICROSOFT SOL SERVER 2005 SERWICE PACK 2

|»

PLEASE MOTE:

Far supplement obtained from server manufacturer or software installer. The server
manufacturer, or the software installer, that distributes the software with the server licenses
thiz supplement to pou, 'ou may uze an ingtance of thiz supplement with each validly
licenzed instance of the product listed above [the "software']. You may naot use the
supplement if you do not have a licensze for the zoftware, The licensze terms for the software
apply to your use of thiz supplement. Contact the manufacturer or installer for support
optionz, Refer to the support number provided with the software.

For supplement obtained from retailer. Microsoft Corporation [or based on where vou live,

one of itz affiiates) icenses thiz zupplement o you, You mag uze an inztance of this

supplement with each validly licensed instance of the product listed above [the “saftware']. J
-

| accept the agreement Fririt |

% do ot accept the agreement

Help | << Back | Hest»» I Cancel |

SQL Server 2005 Service Pack 2 end user license agreement

Microsoft SQL Server 2005 Service Pack 2 Setup

Feature Selection

Thiz zetup program detected the following SGL Server 2005 features. Select the program
features that you would like to update. To zee the detailz of a feature, click on the feature,

- [¥] Setup Suppart Files |—
- [ MSSOLSERVER e A=
[¥] D atabase Services Platfarm %B6
- [ Mutification Services " —
- [#] SOL Server Mative Clent Edition
- [¢#] Client Components Status Fequired

- [F] MSML B.0 Parser

- [ SOLXMLA

- [#] Backward Cornpatibility

- W] Microzoft SOL Server WSS Witer

Details
Thiz iz a required update. ;I

Cancel |

Help | << Back |

Feature Selection Screen
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Microsoft SQL Server 2005 Service Pack 2 Setup

Authentication

Select the authentication mode and account for the instances to upgrade. You can choose to
apply the zettingz to all instances or to a specific ingtance,

v Apply zelection to all instances

Instance Mame I

Authentication I\A-"indc-ws Authentication

Ueer Mame I

Pazswaord I

Froduct | Instance | Authentication | |dzer name | Statuz
Databasze Servic.. MSSOLSERY. .. Windows IMAGE TAG W, Success

< | i
Help | << Back | Hest »» | Cancel |

Authentication Mode Screen

Microsoft SQL Server 2005 Service Pack 2 Setup

Error and Uszage Reporting Settings

Autoratically zend Errar reports for SOL Server 2005 Service Pack 2 to Microsaft or
your corporate error reporting zerver. Error reports include information regarding the

[ condition of SBL Server 2005 Service Pack 2 when an enor occurred, vour hardware
configuration and other data. Ermor reports may unintentionally include personal
information, which will not be uzed by Microsoft,

Automatically send Feature Usage data for SOL Server 2005 Service Pack 2 to
[~ Microsoft. Uzage data includes anonyrmaous infommation about pour hardware
configuration and how pou uze our software and services,

Far more information about aur privacy policy, sending errar reports, or sending usage data,
click Help.

Help | << Back |

Cancel |
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Microsoft SQL Server 2005 Service Pack 2 Setup

Running Processes

The following processes are lacking files that SAL Server 2005 Service Pack 2 must
update. To avoid a computer restart, end these processes, and then click MNext.

Process name | Feature | Type | Llzer name | FID |
MSSOLSERVER S0OL Serve..  Service NT &UTH... 3444
SOLSERVERAGEMT S0L Serve..  Service NT &UTH... 2800
meftesql Databaze ...  Service NT AJTH... 3432
SOLBroveser Database ... Service NT &UTH... 2564

Locked files found. & reboot will be required if proceszes are not ;I Befresh |
clozed.

Help | << Back | ] Cancel |

Microsoft SQL Server 2005 Service Pack 2 Setup

Ready to Install

Setup has enough information to apply the Service Pack.

Toreview of change any settings, click Back. Othenwize, click [nstall to proceed with the
Service Pack ingtallation,

Help | << Back |

Cancel |
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Microsoft SQL Server 2005 Service Pack 2 Setup

Installation Progress

Pleaze wait while the installation proceeds.

Product | Inztance | Status |
O 5etup Support Files In Progress
[ Databaze Services MSSOLSERVER

[ Motification Services

[ 50L Server Mative Client

[ Cliert Components

O t45xML E.0 Parser
OsaLxmMLs

[ B ackward Compatibility

[ Microsoft SOL Server W55 ..

Inztalling ‘Windows Installer file SglSuppart.msi

Frogress...

I

<¢ Back | Hest»» | Carce]

Pending Reboot Files Found |

€ A previous program installation caused unrelated pending File operations. The patch installation will succeed even if
““tr} wour compuker is nok rebooked,

Do wou wank to proceed?

If you did not reboot before installing SP2 you will set this dialog, click yes to continue

Locked Files Found x|

9P The Following files are currently locked,
\"‘J)

In order to prevent a necessary reboot at the end of the patch install process, close down all other applications
before proceeding.

Wiite locked file: CiiProgram FilesiMicrasoft SOL ServeriMasoL, iMSSOLBinm msftesgl.exe (msftesql.exe)
Wtrite locked file: Ci\Program FilesiMicrosoft SOL ServeriMaaoL, MaSQL Binmmsttepoy, dll (msftesql.exe)
Write locked File: Zi\Program FilesiMicrosoft SOL ServeriMSSOL., 13MSS0L Binnt msfte . dll {msftesqgl. exe)
Write locked file: CiiProgram FilesiMicrosoft SQL Serveri90isharedisglbrowser, exe (sglbrowser, exe)

Cancel Try Again Conkinue

If SQL Services are running you will see this dialog, click continue to proceed with the
installation of service pack 2
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Computer Reboot Required x|

\ij) Cne of mare affected files have operations pending.

You should restart your computer to complete this process.

If you require a reboot to finish the installation of service pack 2 you will see this dialog

Microsoft SQL Server 2005 Service Pack 2 Setup

Installation Progress

Pleaze wait while the installation proceeds.

Product | |stance | Statusz |
Setup Support Files Success

Database Services MSSOLSERVER Success

Matification Services Success

SOL Server Mative Client Feboot Required
Client Carmpaonents Success

i SbL B.0 Parzer Success

SOL<ML4 Success

Backward Carmpatibility Success

Microzoft SOL Server VS5 .. Success

Service Pack Completed

|

<¢ Back | Hest »» | Carce] |

Installation Complete
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Microsoft SQL Server 2005 Service Pack 2 Setup

Installation Complete

SOL Server 2005 Service Pack 2 Setup haz finished.

Far a summary of the installation, click Yiew Summary. To continue, click Mest.

Wigw Surnmary |

Product | Instance | Statuz -
Setup Support Files Success

Database Services M5SOLSERVER Success

Maotifization Services Success e
SOL Server Mative Client Reboot Required
Client Compaonents Success

RACYRAL BN Darcar [T i
1| | _’l_l
Details

Log Location: C:%\Program FileshMicrozoft SOL Serverh308Setup -
BootstraphLOG \HotfisRedistd Hotfis_KE921856_SqlSupport. mai.log

Help |

Microsoft SQL Server 2005 Service Pack 2 Setup

Additional Information

By default, users on Windows Yista and later operating spstems are not members of the
Sustern Administrator role for SQL Server or Analysis Services. To add uzers ta the Spstem
Adminiztrator role, uze the check box below to launch the SOL Server 2006 User
Provizgioning T ool for Windows Yista after SP2 installation completes.

¥ Launch the Uzer Pravisioning Toal for Windows Yista after SP2 installation completes.

To view the most recent readme file for this release, see the
SCL Server 2005 Service Pack 2 readme:
http:#fgo. microsoft. comiwlinks?Linkld=63573

To download the latest update of SQL Server 2005 Books Online,
see the Microsoft SQL Server 2005 Books Online download Web site:
hitp:#go. microsoft. com/fwlinks?Linkld=58555

To learn about support options for SOL Server, see the
Microsoft SOL Server support options Web site:
hitp:#go. microsoft. com/fwlink/?linkid=8633

Help |
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14.2 SQL Server 2005 Configuration

1. Start the SQL Server Management Studio and logon to the server using Windows or

SQL Authentication
x

gichﬁuE S 27 Windows Server System
Server lype: IDatahase Engine j
Server name: DEMOKTOT |
Authentication: IWindDws ALthenticatian j
zer name: IDEMEIKT 01 “Administratar j

Pazzword: I

I Eemember password
Connect I Cancel Help Optionz > >

SQL Server 2005 Login Screen

l- Microsoft SL Server Management Studio - |EI|5|

File Edit Wew Tools ‘Window Community Help

5

Dewaey BRI SEHIBDERE S,

Summary] - X
Connect ~ -y;g m a7 ﬂ | ‘_‘.’ T List [+ Raugrt - ‘
= Ld DEMOKTOL {SCL Server 9.0,2047 - DEMOKTO1hA:
O ety ' | DEMOKTO1 (SQL Server 9.0.2047 - DEMOKTO1\Adn
[ Ferver Objects DEMOKTOL 7 Itemis)

[ Replication

[ Management

[ Motification Services
L% SOL Server Agent

[ server Objects

[ Replication

[ Management

[ Notification Services
|_'E)SQL Server Agent

4 | i

Ready 4

SQL Server 2005 Management Studio
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2. Expand security and select the logins folder. Right click logins and select the ‘New
Login’ option
[

icrosoft SQL Server Management Studio =] ]

File Edit Wew Tools ‘Window Community Help

Htewouery | B BGIL SEHS BEBES

0 jorer > 3 X Summary | v X
Comnect~ | 2d m & T = E - 4 ist [~ Rapgrt -
1 | (3 DEMOKTOL (SGL Server 9.0.2047 - DEMOKTO11Ac
Databases i A
= S Security D Loglns
(SR DEMCKTOLYSecurityiLogins & Itemis)
Ay BUILTIM Administrators
75| DEMOKTO145QLServer 2005MSFTEUse
#] DEMOKTO1450L Server2005M35QLse e [ created |
O8] DEMOKTO11SQLServer2005SQLAGent! | | afp) 1) TINGAdministrators 7i17j2006
i NT ALUTHORITY|SYSTEM 28 DEMOKTO150L Server 200SMSF TEUser§DEMOKTD. .. 7/17/2006
& sa £5| DEMOKTO1S0LServer 200SMSSQLUSer SDEMOKTD,., 7/17/2006
3 Server Roles 27 DEMOKTO1 50 Server 200550L AgentUser DEMOK, ., 7/17/2006
‘ggrvgfg;]”;g: A NT AUTHORITY|SYSTEM 7i17j2006
o Asa 4/82003
[ Replication
3 Managemenkt
[ Motification Services
|§J SOL Server Agent
4 | |
Ready 4

... select the logins folder...

3. Create a new sql server account called ktsqluser with the following settings:
a. General Settings:
O SQL Server authentication
O Uncheck ‘Enforce password policy’ (this option is only enabled if SQL
2005 is installed on Windows 2003 Server)
O Default database : master
O Default language : <default>
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% SOL Server authentication

=101 x|
Select apage L5 Seript - Help
A General
Server Roles Logi Ikls luser Search
Uszer Mapping i TS & ﬂl
% Secuables  Windows authentication
12 Status

Password: |uuuu

LConfirm password: I

-

™| Enforce password expiration

=1 Wser must change password|at nest login

' tapped to cerificate

Certificate name: I

| Wapped o asymmetic key

Keyrane |
Server
DEMOETO! Default databaze: Imastel j
Conrection Default language: |<default> j
DEMOKTON \dministrator

g_'fJ “Wigw connection properties

Feady

Ok I Cancel |

4
General Settings Screen
b. Server Roles
O Check the ‘sysadmin’ server role
=10l x|

1% General
Server Roles
User Mapping
Secuables

Server role iz uged to grant server-wide security privileges to a user.

Server roles:

[ bulkadmin
[] dbecreatar

[ diskadmin
[[] processadmin
[ securityadmin
[] serveradmin
[ setupadmin

Connection

Server
DEMOKTO!

Caonnection
DEMOKTON \dministrator

3} “Wigw connection properies

Fieady

ok I Cancel |

4
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c. User Mapping

Server Roles Settings Screen

O Select the master database
O Select the model database
O Select the msdb database

il
59|9C13D393 S Script - Help
2 General
25 Fiol
.'ﬁ} e —— Users mapped to this login:
éﬁ Secuables Map I D atabaze I Lzer I Default Schema I
12 Shatus | master
rmodel
medb
tempdb
¥ | Guest account enabled for: master
[ atabasze role membership for: magter
[0 db_accessadmin
Semver O db_backupoperatar
DEMOKTOT [ db_datareader
) O db_datawriter
Connection [ db_ddladmin
DEMOKTOT Administrator O db_derwdatareader
4 View connection praperties 0 db_denydatavuiter
[ db_owner
[ db_zecurityadmin
& public
Ready

[ ok 1]

Cancel |

User Mapping Settings Screen

d. Securables (No Change)
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,5 Login - New

General
Server Roles
Uzer Mapping

Server
DEMOKTO!

Connection
DEMOKTON \dministrator

!? “Wigw connection properties

~ Ready
Yas®

Securables Settings Screen
e. Status (No Change)

F Login - New

General
Server Roles
User Mapping
Securables
g ot

Server
DEMOKTO!

Connection
DEMOKT 0T Administrator

3 View connection propetties

~ PReady

s’

Status Settings Screen
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Click ‘Ok’ to create the account

If you are using Server 2003 uncheck ‘Enforce password policy’ checkbox on the
General settings for the sa account login

4. Open the SQL Server Surface Area Configuration tool from the SQL Server 2005
configuration tools start menu (Start\Programs\Microsoft SQL Server
2005\Configuration Tools\SQL Server Surface Area Configuration)

55 S0L Server 2005 Surface Area Configuration - |D|ﬂ
Microsoft /4 Windows Server System

SQL Server2005

Help Protect Your 5QL Server

W N

Minimize SAL Server 2005 Surface Area

SOL Server 2005 improves manageability and security by giving administrators maore control over the surface area of local
and remate instances of SHL Server 20085, With the SUL Server 2005 Suface Area Configuration tools, you can eazily:

+ Dizable unuszed services and network protocols for remote connections.
+ Digable unused features of SOL Server components,

For mew installations, uge these tools bo enable required features, services, and netwark protocals that are dizabled by
default. For upgraded instances, use these tools to identify and disable unused features, services, and protocols.

@ iRead more about confiqunng the SOL Server surface area,

Configure Surface Area for localhost [change computer)

@ Surface Area Configuration for Services and Connections

?‘_E'j Surface Area Configuration for Features

SQL Server 2005 Surface Area configuration
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5. Select ‘Surface Area Configuration for Features’
6. Select *xp_cmdshell’, enable the feature and apply the change

I Surface Area Configuration for Features - localhost x|

N

‘1 5QL Server 2005 Surface Area Configuration
& Help Protect Your SQL Server

Enable anly the features required by your applications. Dizabling unuzed features helps protect your zerver by reducing the
surface area. For default settings, see Help.

Select a component, and then configure its features:

= |j MSSOLSERYER The »p_cmdshell extended stored procedure runs operating system commands from within
B [J Database Engine the Database Engine. Enable xp_cmdshell anly if your applications or seripts must use
£ Hoe Remote Queries wp_cmdshel bo run operating systemn commands.
CLR Integration
Dz
Databage Mail
Mative #ML Web Servic ¥ Enable «p_cmdshel
OLE Automation
Service Braker
SOL Mail
Wwieh Aszistant
=+ xp_cmdshell

4 | B

Wiew by Instance | View by Component

oK. | Cancel | Apply Help

Surface Area Configuration for Features
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15 KwikTag Prerequisites
Prerequisites should only be installed after IIS &/or SQL has been installed

15.1 Installing .NET Framework 1.1 SP1

This is only required if you are installing on a x64 sql server.

The Microsoft .NET Framework 1.1 SP1 can be installed in two different ways, through
Windows/Microsoft Update or by manual installation. If you choose to install the framework
using Windows/Microsoft Update you will need to do a ‘Custom’ update and the framework
can be selected in the ‘Recommended’ updates section. This section will cover the manual
installation of the .net framework.

Before you install 1.1 SP1 you must be aware of a few things:
O What operating system am I installing on?

o Windows 2003 x64 does not have the .net framework installed at all and you
must install the 1.1 framework before you can install 1.1 sp1l

O What do I need to install?

o As stated previously, Windows 2003 x64 systems need to have the 1.1 .net
framework installed, and then 1.1 spl can be applied

O Where do I download these from?

o The following links are accurate as of the time of this writing:
= The full 1.1 redistributable package (Windows 2003 x64) -
http://www.microsoft.com/downloads/details.aspx?FamilyID=262d25e
3-f589-4842-8157-034d1e7cf3a3&DisplayLang=en
» Framework 1.1 SP1 (Windows 2003 x64) -
http://www.microsoft.com/downloads/details.aspx?familyid=A8F5654F
-088E-40B2-BBDB-A83353618B38&displaylang=en

NOTE: There are 2 different versions of 1.1 sp1l listed above; One is only
for x86 versions of Windows Server 2003 and the other are for Windows 2000

and XP systems. Be sure you download and install the right patch for
your system.

The following are step by step instructions for installing the 1.1 .NET Framework and 1.1
SP1. These instructions already assume you have downloaded the appropriate files as
previously stated.

O Step 1 - Double click the dotnetfx.exe to start the installation of the 1.1 framework.
You will be asked if you want to install the 1.1 framework, click yes to continue

O Step 2 - A new dialog window is displayed called License Agreement. Select'I
agree’ the Install button will become enabled, click it to begin the installation process
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"5 Microsoft .MET Framework 1.1 Setup = | O] =
L

.- " License Agreement

Microsoft | :l

- (& copy of this license iz availdble for printing at
httyfizo microsoft corafiwlink?TinkId=12283 )
[ ] . Trem
SUPPLEL-'IE
| LICEMNGE AGEEEMEINT FORE

AT R C=MET SO EFTWARFR ;I

| hawve read, understood and agree to the terms of the
End Uszer Licenze Agreement and 2o zighify by clicking
" agree" and proceeding bo uze thiz product.

I | agree
* | do not agree

[rztall Cancel |

License Agreement Dialog

=15
.' | Installing Components

The following items are being installed on your compriter

M icrﬂSﬂ'ﬂ' MET Framewaork Files

Net

. |

Stopping services

Time remaining; 23 seconds

I Semvice: 15 Admin Service

Installing Components Dialog

[0 Step 3 - Once installation is complete click the ‘OK’ button to finish the installation
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i'g!,'l Microsoft .NET Framework 1.1 Setup o ]

Inztallation of Microzaft MET Framewark 1.7 iz complete.

O Step 4 - Double click NDP1.1sp1-KB867460-X86.exe
O Step 5 - You will be asked if you want to install 1.1 SP1 on 1.1, click ‘OK’ to continue

the install

Microsoft .NET Framework 1.1 Service Pack 1 (KEB&T460}) X|

Do you want to install Microsoft NET Framework 1.1 Service Pack 1 (KB3E7 460)
an Micragoft NET Framewaorlc 1.17

Cancel |

O Step 6 - A new dialog window is displayed called License Agreement. Select ‘I

accept’ to begin the installation process
O Step 7 — A dialog for installing components will be displayed briefly. installation is

complete click the *OK’ button to finish the installation
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Microsoft .MNET Framework 1.1 Service Pack 1 (KBES867460) Licens

e ELILA for printing
SUPFLEMENTAL EMD LUSER LICEMSE AGREEMENT ﬂ

SOFTWARE LUFDATE FOR MICROSOFT WINDOWS OFERATING SYSTEM
SOFTWARE

FLEASE READ THIS SUFFLEMEMNTAL EMND-USER LICENSE AGREEMEMNT
"SUFFLEMENTAL EULAY CAREFULLY. BY INSTALLING OR USING THE
SOFTWARE THAT ACCOMEANIES THIS SUFFLEMENTAL EUILA, OL
AGREE TO THE TERMS OF THIS SUIFFLEMENTAL ELILA, IFYOLU DO NOT
AGREE, DO NMOT INSTALL OR USE THE SOFTWARE.

=l

1 [ NN |

Flease read the rights and restrictions described in the End User License
Agreement (ELILA). To acceptthe terms of this ELILA, click "l accept”. To decline
the terms of this ELILA, click "l decline”. Befare this software can be installed, the

terms of this EULA must be accepted.

| accept | | decline |

License Agreement Dialog

Microsoft .NET Framework 1.1 Service Pack 1 {KEE&GT460})

bicrosoft MET Framewark 1.1 Service Fack 1 (KBS67 60 was successfully
installed on Microsoft MET Framework 1.1,
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15.1.1 Installing KwikTag NS with a different Instance Name

Immediately after starting the install, and all files have been copied, go to Program
Files\KwikTag Support and copy install_ns.bat and uninstall_ns.bat to another folder
Edit install_ns.bat and REM out all of the commands

Quickly browse to Program Files\KwikTag\Messaging\Bin and make a copy of
AddSubscriptions.vbs

The install will complete successfully, click Finish

Open the install_ns.bat file in Notepad and change the Instance Name to the name
you want. There are three places to change this: two after -name and one after
NS$

6. Save and close the file

7. Change the value of the <InstanceName> node to the name you want.

8. Save and close the file

9. Edit the AddSubscriptions.vbs file and change the InstanceName value to the name
of the instance you are creating.

10. Save and close the file

11. Move the AddSubscriptions.vbs to the Program Files\KwikTag\Messaging\Bin

12. Remove all the REM statements from install_ns.bat and add PAUSE as the final line
(this lets you see the results in the command window)

13.Run install_ns.bat
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15.2 SQL Notification Services 9.0

1. Select “Server components, tools, Books Online, and samples” from the install

section of the splash screen

SQAL Server 2005 (Disc 1 of 2)

ent tools,

Online, and
will require both
stallation discs.

Microsoft'

SQL Server 2005
Standard Edition

Prepare
Review hardware and software requirements
Read the release notes

Install SQL Server Upgrade Advisor

Install

Server components, tools, Books Online, and
samples

Run the SOL Native Client Installation Wizard

Other Information
Browse this CD
Yisit the SQL Server website

Read the SQL Server license agreement

Exit

SQL Server 2005 Startup Splash Screen

All rights reserved. Company Confidential
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2. Read and accept the end user license agreement and click next

P Microsoft SOL Server 2005 Setup ﬂ

End Uszer Licenze Agreement

MICROSOFT SOFTWARE LICENSE TEEMS ﬂ

MICROSOFT S0QL SERVER 2005 STANDARD AND ENTERPRISE
EDITIONS

These license terms are an agreensht between
Microsoft Corporation (or based on where you
live, one of it=s affiliates) and wvou. Flease
read them. They apply to the =oftware named
abowve, which includes the media on which vou
received i1t, i1f any. The term=s also apply to any
Micro=soft

* ypdates,
* =upplements,

*¥ Internet-ba=s=ed =ervice=s. and

* =zupport services v|

[ i accept the licensing terms and conditions

Print | et = I Cancel |

End User License Agreement

3. Install SQL Server 2005 prerequisites

P Microsoft SOL Server 2005 Setup 5[

Installing Prerequisites

Installz: zoftware components required prior ta instaling SGL
Server

SOL Server Cornponent Update will install the following components ;|
required for SOL Server Setup:

MET Frarneswork 2.0
Microsoft SOL Mative Client
Microsoft SOL Server 2005 Setup Support Files

Click Install to continue,

Click “Install” to begin the installation of the prerequisites
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P Microsoft SOL Server 2005 Setup 5[

Inztalling Prerequisites

Installz: zoftware components required prior ta instaling SGL
Server.

SOL Server Cornponent Update will install the following components ;|
required for SOL Server Setup:

¥ MWET Framewark 2.0
¥ Microsoft SOL Mative Clent
¥ Microsoft SOL Server 2005 Setup Support Files

The required cormponents were instaled successully.

Lance| |

Click “Next” when prerequisite installation is finished to continue

]inzl Microsoft SOL Seryer 2005 Setup ﬂ

» Welcome to the Microsoft SQL
Server Installation Wizard

Setup will help vou install, modify or remove Microsoft
SOL Server. To continue, chick Mest.

< Back | Cancel |

SQL Server Installation Wizard Welcome Screen - Click Next
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4. The results of the system check the installation performed

earlier are displayed on

the “System Configuration Check” dialog screen. If any errors or warnings are

discovered address them before continuing the installation

]inil Microsoft SQL Seryver 2005 Setup ﬂ

System Configuration Check

“Wait while the system is checked for patential installation

problems.

>
@ 14 Tatal 0 Ermor
Success 14 Success 0 waming
Details:
_I Action | Status Message |;|
@ 5 Feature Requiremernt Success
@  Pending Reboot Requirement Success
@ Performance Monitar Counter Require... | Success
@ Default Installation Path Permizzion Re...  Success
@ Intemet Explorer Requirement Success
@ COM Plus Catalog Requirement Success
@ ASP.MNetWersion Registration Require... | Success
@ Minimum MDAC Yersion Bequirement Success
-
Filter - | Stop Beport =
Help |

System Configuration Check Screen
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5. Name: Use appropriate naming convention
6. Company: Use appropriate nhaming convention
7. CD Key: Insert Customer CD Key here

ii;‘!r" Microsoft SOL Server 2005 Setup il
Registration Information

The following inFarmation will personalize wour inskallation,

The Mame Figld must be Filled in prior to praceeding. The Company Field is optional.

Marme:!

Company:

|Imau;|eTagJ Inc,

Please enter wour 25 character Product Kew. You can find this number on the welow

ckicker in the CD liner notes or the CO sleeve,
Help | = Back: I [ext = I Cancel

Registration Information Screen
8. Select the following components to install:
O Notification Services
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i'g!;'- Microsoft SOL Server 2005 Setup 5'

Components to Install
Select the components toinstall or upgrade.

[~ 50l Server Dakabase Services

[T Create a SQL Server Failover clister

[~ Analysis Services

[T Create am fnalysis Server Failover cluster
[~ Reporting Services

[~ Integration Services

[ Workskation components, Books Online and development taols

For rare aptions, cick Advanced, advanced |
Help | < Back I ext = I Cancel |

Components to Install Screen

9. Do not select any of the error and usage reporting settings

ii|1_!;1' Microsoft SOL Server 2005 Setup il

Error and Usage Report Settings

Help Microsoft improve some of the SOL Server 2005 components
and services.

@utomatically send Error reports for SQL Server 2005 to Microsoft or your corporate
Error reporting server, Error reports include inforrnation regarding the condition of SQL

[ Berver 2005 when an error occurred, your hardware configuration and other data. Error
reports may unintentionally include personal information, which will not be used by i
Microsoft,

Automatically send Feature Usage data For S0L Server 2005 to Microsoft, Usage data
[ includes anonymous information about wour hardware configuration and how you use aur
software and services,

For mare infarmation on the error reporting Feature and the type of information sent, click
Help,

Help | < Back I ext = I Cancel

Error and Usage Report Settings Screen
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10. Verify the installation settings and complete the installation
x|

Ready to Install
Setup is ready to begin installation.

= |

Setup has enough information to skark copying the program files, To proceed, click Install, To
change any of wour installation settings, click Back. To exit setup, dick Cancel.

The following components will be installed:

. Notification Services

Help | < Back | Inskall I Cancel |

¥ Microsoft SQL Server 2005 Setup 5[

Setup Progress

The selected components are being configured

)
Produck | Skatus
MSHMLE
SOLAML
@SOL Setup Support Files Setup finished
(4 50L Native Client Setup finished
(G owcit Setup Finished
{#)30L Server Backward-Compatibiity Files  Configuring components. ..
Motification Services
—atatus
ENNRNNNENENER
== Back [ext == Cancel
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F Microsoft SQL Server 2005 Setup 5[

Completing Microsoft SQL Server 2005 Setup
Setup has finished configuration of Microsoft QL Server 2005

Refer to the setup error logs For information describing any Failureds) that occurred during
setup. Click Finish ko exit the installation wizard.

Surmmary Log

To minimize the server surface area of SQL Server 2005, some Features and services are
disabled by default For new installations. To configure the surface area of SOL Server, use the

Surface Area Configuration tool,

Analysiz Services o
+  |fAnalysiz Services was upgraded from SOL Server 2000, all cubes,

ditnenzions, and mining models must be reprocessed uzing SQL Server
kanagement Studio.

Reporting Services

+«  The Reporting Services installation options vou specified in Setup
determine whether further configuration iz required before ywou can
access the repart server. fwou installed the default configuration, the

report server can be used immediately. If vou installed just the program
dilmm rmas vt vraim Hem e midbiinm D mtniimmm (Trmmflmiiemdimin bmm | bm A L dLe j

Hep Fsh |

11.Install SQL Server 2005 Service Pack 2

Microsoft SOL Server 2005 Service Pack 2 Setup

Welcome

Wwelcome to the SGL Server 2005 Service Pack 2 Setup. This ingtallation provides updates
for SAL Server 2005,

Far a list of updates that SOL Server 2005 Service Pack 2 provides, see the Microsoft
knowledoge baze article:

hitp:# #zupport. microsoft comd Mk bid=921 896

To continue, click Next.

<< Back |

Cahicel

SQL Server 2005 Service Pack 2 Welcome Screen
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Microsoft SQL Server 2005 Service Pack 2 Setup

License Terms

Important: 'ou must accept the enclozed License Terms before pou can use this product. If
you do not accept the terms of the Licensze Terms, you are not authorized to uze this
product ahd should return the praduct to wour place of purchaze.

MICROSOFT SOL SERVER 2005 SERWICE PACK 2

|»

PLEASE MOTE:

Far supplement obtained from server manufacturer or software installer. The server
manufacturer, or the software installer, that distributes the software with the server licenses
thiz supplement to pou, 'ou may uze an ingtance of thiz supplement with each validly
licenzed instance of the product listed above [the "software']. You may naot use the
supplement if you do not have a licensze for the zoftware, The licensze terms for the software
apply to your use of thiz supplement. Contact the manufacturer or installer for support
optionz, Refer to the support number provided with the software.

For supplement obtained from retailer. Microsoft Corporation [or based on where vou live,

one of itz affiiates) icenses thiz zupplement o you, You mag uze an inztance of this

supplement with each validly licensed instance of the product listed above [the “saftware']. J
-

| accept the agreement Fririt |

% do ot accept the agreement

Help | << Back | Hest»» I Cancel |

SQL Server 2005 Service Pack 2 end user license agreement

Microsoft SQL Server 2005 Service Pack 2 Setup

Feature Selection

Thiz zetup program detected the following SGL Server 2005 features. Select the program
features that you would like to update. To zee the detailz of a feature, click on the feature,

- [¥] Setup Suppart Files |—
- [ MSSOLSERVER e A=
[¥] D atabase Services Platfarm %B6
- [ Mutification Services " —
- [#] SOL Server Mative Clent Edition
- [¢#] Client Components Status Fequired

- [F] MSML B.0 Parser

- [ SOLXMLA

- [#] Backward Cornpatibility

- W] Microzoft SOL Server WSS Witer

Details
Thiz iz a required update. ;I

Cancel |

Help | << Back |

Feature Selection Screen
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Microsoft SQL Server 2005 Service Pack 2 Setup

Authentication

Select the authentication mode and account for the instances to upgrade. You can choose to
apply the zettingz to all instances or to a specific ingtance,

v Apply zelection to all instances

Instance Mame I

Authentication I\A-"indc-ws Authentication

Ueer Mame I

Pazswaord I

Froduct | Instance | Authentication | |dzer name | Statuz
Databasze Servic.. MSSOLSERY. .. Windows IMAGE TAG W, Success

< | i
Help | << Back | Hest »» | Cancel |

Authentication Mode Screen

Microsoft SQL Server 2005 Service Pack 2 Setup

Error and Uszage Reporting Settings

Autoratically zend Errar reports for SOL Server 2005 Service Pack 2 to Microsaft or
your corporate error reporting zerver. Error reports include information regarding the

[ condition of SBL Server 2005 Service Pack 2 when an enor occurred, vour hardware
configuration and other data. Ermor reports may unintentionally include personal
information, which will not be uzed by Microsoft,

Automatically send Feature Usage data for SOL Server 2005 Service Pack 2 to
[~ Microsoft. Uzage data includes anonyrmaous infommation about pour hardware
configuration and how pou uze our software and services,

Far more information about aur privacy policy, sending errar reports, or sending usage data,
click Help.

Help | << Back |

Cancel |
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Microsoft SQL Server 2005 Service Pack 2 Setup

Running Processes

The following processes are lacking files that SAL Server 2005 Service Pack 2 must
update. To avoid a computer restart, end these processes, and then click MNext.

Process name | Feature | Type | Llzer name | FID |
MSSOLSERVER S0OL Serve..  Service NT &UTH... 3444
SOLSERVERAGEMT S0L Serve..  Service NT &UTH... 2800
meftesql Databaze ...  Service NT AJTH... 3432
SOLBroveser Database ... Service NT &UTH... 2564

Locked files found. & reboot will be required if proceszes are not ;I Befresh |
clozed.

Help | << Back | ] Cancel |

Microsoft SQL Server 2005 Service Pack 2 Setup

Ready to Install

Setup has enough information to apply the Service Pack.

Toreview of change any settings, click Back. Othenwize, click [nstall to proceed with the
Service Pack ingtallation,

Help | << Back |

Cancel |
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Microsoft SQL Server 2005 Service Pack 2 Setup

Installation Progress

Pleaze wait while the installation proceeds.

Product | Inztance | Status |
O 5etup Support Files In Progress
[ Databaze Services MSSOLSERVER

[ Motification Services

[ 50L Server Mative Client

[ Cliert Components

O t45xML E.0 Parser
OsaLxmMLs

[ B ackward Compatibility

[ Microsoft SOL Server W55 ..

Inztalling ‘Windows Installer file SglSuppart.msi

Frogress...

I

<¢ Back | Hest»» | Carce]

Pending Reboot Files Found |

€ A previous program installation caused unrelated pending File operations. The patch installation will succeed even if
““tr} wour compuker is nok rebooked,

Do wou wank to proceed?

If you did not reboot before installing SP2 you will set this dialog, click yes to continue

Locked Files Found x|

9P The Following files are currently locked,
\"‘J)

In order to prevent a necessary reboot at the end of the patch install process, close down all other applications
before proceeding.

Wiite locked file: CiiProgram FilesiMicrasoft SOL ServeriMasoL, iMSSOLBinm msftesgl.exe (msftesql.exe)
Wtrite locked file: Ci\Program FilesiMicrosoft SOL ServeriMaaoL, MaSQL Binmmsttepoy, dll (msftesql.exe)
Write locked File: Zi\Program FilesiMicrosoft SOL ServeriMSSOL., 13MSS0L Binnt msfte . dll {msftesqgl. exe)
Write locked file: CiiProgram FilesiMicrosoft SQL Serveri90isharedisglbrowser, exe (sglbrowser, exe)

Cancel Try Again Conkinue

If SQL Services are running you will see this dialog, click continue to proceed with the
installation of service pack 2
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Computer Reboot Required x|

\ij) Cne of mare affected files have operations pending.

You should restart your computer to complete this process.

If you require a reboot to finish the installation of service pack 2 you will see this dialog

Microsoft SQL Server 2005 Service Pack 2 Setup

Installation Progress

Pleaze wait while the installation proceeds.

Product | |stance | Statusz |
Setup Support Files Success

Database Services MSSOLSERVER Success

Matification Services Success

SOL Server Mative Client Feboot Required
Client Carmpaonents Success

i SbL B.0 Parzer Success

SOL<ML4 Success

Backward Carmpatibility Success

Microzoft SOL Server VS5 .. Success

Service Pack Completed

|

<¢ Back | Hest »» | Carce] |

Installation Complete
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Microsoft SQL Server 2005 Service Pack 2 Setup

Installation Complete

SOL Server 2005 Service Pack 2 Setup haz finished.

Far a summary of the installation, click Yiew Summary. To continue, click Mest.

Wigw Surnmary |

Product | Instance | Statuz -
Setup Support Files Success

Database Services M5SOLSERVER Success

Maotifization Services Success e
SOL Server Mative Client Reboot Required
Client Compaonents Success

RACYRAL BN Darcar [T i
1| | _’l_l
Details

Log Location: C:%\Program FileshMicrozoft SOL Serverh308Setup -
BootstraphLOG \HotfisRedistd Hotfis_KE921856_SqlSupport. mai.log

Help |

Microsoft SQL Server 2005 Service Pack 2 Setup

Additional Information

By default, users on Windows Yista and later operating spstems are not members of the
Sustern Administrator role for SQL Server or Analysis Services. To add uzers ta the Spstem
Adminiztrator role, uze the check box below to launch the SOL Server 2006 User
Provizgioning T ool for Windows Yista after SP2 installation completes.

¥ Launch the Uzer Pravisioning Toal for Windows Yista after SP2 installation completes.

To view the most recent readme file for this release, see the
SCL Server 2005 Service Pack 2 readme:
http:#fgo. microsoft. comiwlinks?Linkld=63573

To download the latest update of SQL Server 2005 Books Online,
see the Microsoft SQL Server 2005 Books Online download Web site:
hitp:#go. microsoft. com/fwlinks?Linkld=58555

To learn about support options for SOL Server, see the
Microsoft SOL Server support options Web site:
hitp:#go. microsoft. com/fwlink/?linkid=8633

Help |
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16 Security Settings

16.1
16.1

Windows Server 2003

1 Introduction

This document details the security permissions that can be applied to a Kwiktag system
to provide file level security. The following configuration is recommended for any
Kwiktag system that will be accessible to an external network.

16.1

2 Format Conventions and Definitions

Root - This usually refers to a drive, or the main directory being referred to. I.e. Give
the local admins group full permissions at the root of C:/.

Local - This refers to the local machine. This is quite important as when you are joined
to a domain, by default, the domain users are displayed so you will have to select the
local machine from the dropdown list.

[Text] - This refers to a button.

{Text} - This refers to a server name. I.e. itkwiktag might show up like
this....{itkwiktag }

16.1.3 Account Security
1. Right click my computer
2. Select Manage
3. Expand Local Users and Groups and click on the Users folder
4. Right click the IUSR account and rename to Webuser
5. Right click the Webuser account and select properties
6. Verify that the checkboxes for User cannot change password and Password never
expires are checked and set the standard password. Click [Apply]
7. Right click the Users folder and select new user
8. Username is Webappmgr
9. Fullname is Launch IIS Process Account
10. Description is Account for IIS to start out of process applications
11. Enter and confirm the standard password for this account
12.Uncheck the checkbox for User must change password at next logon
13. Check the checkboxes for User cannot change password and Password never expires
14.[Create]
15.[Close]
16. Add WebAppMgr to the IIS_WPG Group
17. Create Group named ktService and add the internal Network Service and Local
Service accounts
18. Close Computer Management
19. Click Start/Programs/Administrative Tools/Component Services
20. Expand Component Services
21. Expand Computers
22.Expand My Computer
23.Expand Com+ Applications
24. Right click IIS Out-Of-Process Pooled Applications and select properties
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25,
26
27.
28.
29.
30.
31.
32.
33.
34
35
36.
37.
38.

39.
40.
41
42
43.
44,
45.
46.
47.
48.
49.
50
51.
52.
53.
54,
55.
56.
57.

16.1.

Click the Identity Tab

.[Browse]

Select the local Webappmgr account
[OK]

Enter and confirm the password
[Apply]

[OK]

Open the KwikTag Soap Package
Open the Roles folder

.Add WebAppMgr to the Creator Owner Role
.Open the KwikTag API Package

Open the Roles folder

Add WebAppMgr to the Creator Owner Role

Change the IUSR account to Webuser in all KwikTag Com+ Application Roles where
IUSR exists.

Close Component Services

Open the Internet Information Services Manager'?

.Right Click on Websites
.[Properties]

Click the Directory Security Tab

[Edit]

In Anonymous Access click [Edit]

[Browse...]

Select the local Webuser account

Enter the password

Check the checkbox for Allow IIS to control password

.Click [Yes] when the IIS WWW Configuration dialogue box comes up

[OK]

[OK]

[Apply]

[OK]

[OK]

Change the IIS Application Pools to run as WebAppMgr
Close the Internet Information Services Manager

4 Setting NTFS Permissions

Setting NTFS permissions is very straightforward. The following is an example of how to set
NTFS permissions for the C:\ Drive. The same process is used for the D:\ Drive and also for
setting permissions on files and folders.

1
2
3
4
5.
6.
7
8
9
1

0.

. At the root of C:\ right click the C:\ drive and select the security tab

[Add]

Select the local machine from the dropdown menu
Multi-select the local administrators group and System
[Add]

[OK]

Select the administrators group

Check the checkbox for Full Control

Select System

Check the checkbox for Full Control

12 Steps 31 through 48 are only applied to the web server
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11. Select the everyone group

12.[Remove]
13.[Advanced]

14. Check the checkbox for Reset permissions on all child objects...

15. [Ok]

16. You will get a message box telling you that the pagefile.sys is in use and cannot be
written to...click [Ok]

17.[OK]

16.1.5

Permissions Matrix

The following matrix provides the specific permissions that are required for a Kwiktag
system to function. The detailed instructions are included above, but for reference the
permissions are listed here in an easier to read format. For all permissions listed in the
matrix you must click the Reset permissions on all child objects under the Advanced tab.

Directory Account/Group Permissions Apply on to
C:\ Administrators, Full Control This folder, subfolders,
System, and files
Creator/Owner
KtService Read & Execute This folder, subfolders,
and files
C:\ Program Webuser, Read & Execute This folder, subfolders,
Files\Common Files Webappmgr and files
C:\ Program Webuser, Read & Execute This folder, subfolders,
Files\Kwiktag Webappmgr, FTP and files
C:\Windows Webuser Read & Execute This folder, subfolders,
and files
Webappmgr Full Control This folder, subfolders,
and files
C:\Windows\System | KtService Full Control This folder, subfolders,
32\msdtc and files
C:\Windows\System | IIS_WPG Full Control This folder, subfolders,
32\inetsrv\ASPComp and files
iledTemplates
D:\ Administrators, Full Control This folder, subfolders,
System, and files
Creator/Owner
KtService Read & Execute This folder, subfolders,
and files
D:\Logs Webuser, Read & Execute, This folder, subfolders,
Webappmgr Write and files
D:\Kwiktag Webuser, Read & Execute, This folder, subfolders,
Webappmgr Modify and files
D:\Kwiktag\Input FTP Read & Execute, This folder, subfolders,
Write and files
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17 Integration Notes

17.1 Named Instances

When installing any KwikTag or Microsoft components on a SQL Named instance the correct
syntax for the SQL Server Name is servername\instancename

17.2 Com+ Packages

The following instructions assume that you have access to the Administrative Tools
though the Start Menu Programs listing. If you do not, you can reach administrative
tools by going though the control panel which is also available through the start
menu.

Also, some of the following steps may differ slightly between OS versions. Major
differences are documented.

17.2.1 Creating Com+ Packages Manually

1.

2.
3.

Open the Component Services MMC (Start -> Programs -> Administrative Tools ->
Component Services)

Expand Component Services until you get to the COM+ Applications Folder

With the COM+ Applications Folder selected, click Action -> New -> Application, or
you can right click the COM+ Applications Folder and select New -> Application.
Either way should open the ‘Welcome to the COM+ Application Install Wizard’ dialog.
Click Next and you should be taken to the next dialog screen where you should have
the following options:

a. Install pre-built application(s)

b. Create an empty application

Select create an empty application which we will add components to later.
After you have selected the type of application to build, you will then be taken to a
dialog prompting you to name your package and to select an Activation Type.

a. Enter a name for the new application: The naming convention for
KwikTag Com+ Applications is to prefix the package name with KwikTag and
then add a descriptive name to that. For example the DAL Com+ package
name would be KwikTag DAL

b. There are two activation types:

i. Library application: Components will be activated in the creator’s
process
ii. Server application: Components will be activated in a dedicated
server process
We want the Com+ application to run as a dedicated server process, so select
the Server application type if it is not selected by default.

6. Next we have to set the application identity. You have the following two options:

a. Interactive User: When a package is running as the interactive user, it will
run as the current logged on user. This is bad for KwikTag, because it
requires that the user be logged into the station at all times for the
application to run.

b. This User: The application will run under the context of this user account
regardless of if the user is logged in or not.

Select This User, and specify a user account to run the application. Usually this is
the ktuser account.
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7.

Click Finish

17.2.2 Adding Com+ Components Manually

1.

uhwn

o

Open the Component Services MMC (Start -> Programs -> Administrative Tools ->
Component Services)
Expand Component Services until you get to the COM+ Applications Folder
Expand the Com+ Application you want to add components to such as KwikTag DAL
Select the Components subdirectory
Select Action -> New -> Component, or you can right click the components folder
and select New -> Component. Either way should open the wizard
Click Next and you should be taken to the next dialog screen where you should have
the following options:

a. Install new component(s)

b. Import component(s) that are already registered

c. Install new event class(es)
Select Install new component(s)
Next you will have to browse to the location of the files you want to add to the
KwikTag DAL Application. For example C:\Program Files\KwikTag\Com Plus
Applications\KwikTag DAL
Select the file(s) you want to add and click open
Click Next, then click Finish

17.3 Creating Com+ Roles Manually

=

uhwN

NOo

Note: We currently use the CreatorOwner Role for our KwikTag Com+ Packages.
This role already exists by default so currently there is no need to manually create a
role.

Open the Component Services MMC (Start -> Programs -> Administrative Tools ->
Component Services)

Expand Component Services until you get to the COM+ Applications Folder

Expand the Com+ Application you want to add components to such as KwikTag DAL
Expand Roles

Select Roles click Action -> New -> Role or you can right click the Roles folder and
select New -> Role

Enter a name for the Role

Click OK

17.4 Adding Users and Groups to Com+ Roles

1.

Open the Component Services MMC (Start -> Programs -> Administrative Tools ->
Component Services)

2. Expand Component Services until you get to the COM+ Applications Folder

3. Expand the Com+ Application you want to add components to such as KwikTag DAL

4. Expand Roles

5. Expand CreatorOwner

6. Expand Users

7. Select Users click Action -> New -> User or you can right click the Users folder and
select New -> User

8. Click the Object Types button and make sure that the check box for Groups is
checked and click OK

9. Select another location if necessary
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10.

Enter a name and click Check Names. i.e. enter ktuser and click the Check Names
button. If a match is found then the name will be underlined, if no match was found
you will be prompted to try another name or location. Once you have entered a
name(s) that you wish to add click OK and the user is now added to the
CreatorOwner role for that Com+ Application.

17.5 Creating Com+ Proxies

1.

ouhwnN

5O ®N

11.

Open the Component Services MMC (Start -> Programs -> Administrative Tools ->
Component Services)

Expand Component Services until you get to the COM+ Applications Folder

Select the Com+ Package you want to proxy

Select Action -> Export or right click the application and select Export

Click Next on the ‘Welcome to the Com+ Application Export Wizard’ dialog

Click Browse to select a location and name for your Com+ Proxy. Such as
C:\Program Files\KwikTag\Support\Proxies\KwikTag DAL Proxy. Once you click the
Save button the .msi extension will automatically be appended to the file name
Select Application proxy

Click Next

Click Finish

.There are now two new files in the C:\Program Files\KwikTag\Support\Proxies

directory:
a. KwikTag DAL Proxy.msi
b. KwikTag DAL Proxy.cab
To install a proxy, copy these files to another machine and run the .msi file

Note: For proxying to work, the same user account must exist on both machines
with the same password.
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17.6 Creating an FTP Virtual Directory

1. Start/Program Files/Administrative Tools/Internet Services Manager on the KwikTag
server.

2. Highlight Default FTP Site

3. Right click Default FTP Site

4. New/Virtual Directory

5. [Next]

6. Name the directory (DC is the standard name for Document Center for other devices
choose a name that will help identify the device)

7. [Next]

8. [Browse] to the input directory for your input device (use the directory that
ktagFolderInputSvc is using, by default it is d:\Kwiktag\input)

9. [Next]

10. Check the checkbox for Write

11. [Next]

12.[Finish]

13. Create an Account for FTP named ktFTPUser with the same rights/permissions as the
IUSR account

14. Note this user and password for the input device configuration

15. Change the Security Account for the Default FTP site to use this account and
password

16. Restart IIS
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17.7 Manually installing the sql notification service instance for
KwikTag

1. Open the support directory in C:\Program Files\KwikTag (assumes an installation to
C:\)

2. Run install_ns.bat (prior to running this you may edit this file to include pause
commands to watch the installation process)

3. Run Upgrade34SP4NS.sql using query Analyzer

17.8 Manually installing a customized instance of SQL NS for
KwikTag

NOTE: By customizing the SQL Notification Service instance from the default, when
applying future updates you will need to use the ‘Bypass update of SQL Notification
Services’ option and manually update after the installation. If the .bat files are not
available in the ?:\Program Files\KwikTag\Support directory “template” copies can be
found on the KwikTag CD

1. Edit the appConfig.xml located in C:\Program Files\Messaging\Config\KwikTag
a. Change the InstanceName from KwikTag to the desired name
2. Edit the install_ns.bat located in the C:\Program Files\KwikTag\Support directory
a. Replace the KwikTag in the lines where -name KwikTag appears to match the
InstanceName you specified in the appConfig.xml
b. Replace NS$KwikTag to match the InstanceName you specified in the
appConfig.xml
3. Edit the uninstall_ns.bat located in the C:\Program Files\KwikTag\Support directory
a. Replace the KwikTag in the lines where -name KwikTag appears to match the
InstanceName you specified in the appConfig.xml
b. Replace NS$KwikTag to match the InstanceName you specified in the
appConfig.xml
4. Edit the update_ns.bat located in the C:\Program Files\KwikTag\Support directory
a. Replace the KwikTag in the lines where -name KwikTag appears to match the
InstanceName you specified in the appConfig.xml
b. Replace NS$KwikTag to match the InstanceName you specified in the
appConfig.xml
5. Run install_ns.bat
6. Edit Upgrade34SP4NS.sql
a. Change ‘KwikTagNSMain’ to your InstanceNameNSMain
b. Change ‘KwikTagKwikTagMessages’ to your InstanceNameKwikTagMessages
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18 Checklists

18.1 Windows server 2003 minimum requirements

Installations on 64-bit operating systems, SQL server clusters, Domain
Controllers, and Microsoft Small Business Server are not supported.

These are the minimum configuration settings required for KwikTag to function on

Windows Server 2003. For detailed instructions for installing and configuring a
Windows Server 2003 machine please refer to the following sections:

Section 13.1 - Windows Server 2003 OS Installation

Section 13.2 - Internet Information Services 6.0 Setup
Section 14.1- Installing and Configuring Microsoft SQL Server
Section 15 - Installing KwikTag Prerequisites

Minimum required windows services

KwikTag works with default Windows installed services.

Com + Event System

Com + System Application
Cryptographic Services

DHCP Client

Distributed File System

Distributed Transaction Coordinator
DNS Client

Error Reporting Service

Event Log

FTP Publishing Service (only if using FTP scan device)
HTTP SSL (IIS dependency)

IIS Admin Service (installed by IIS)

All KwikTag Services (installed by KwikTag)
Logical Disk Manager

MSSQLSERVER (installed by SQL 2000)
Net Logon

Network Connections

Network Location Awareness (NLA)
NS$KwikTag (installed by KwikTag)
NTLM Security Support Provider

Plug and Play

Protected Storage

Remote Procedure Call (RPC)

Security Accounts Manager

Server

SNMP

SQLSERVERAGENT (installed by SQL 2000)
System Event Notification

Task Scheduler

TCP/IP NetBIOS Helper

Terminal Services

OO00O00O0O00O00O0O0O00O0O0O000O00OO000OO0O0O00O0O00oOoaan
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Windows Management Instrumentation

Windows Time

Workstation

World Wide Web Publishing Service (installed by IIS)

ooono

Required local accounts for KwikTag

O KwikTag requires a local windows user account that must be added to the local
Administrators group and have “logon as batch job” and “logon as a service”.

The recommended name for this account is ktuser. Verify there is no Domain or
local policy that overrides these settings.

O IUSR_Servername and IWAM_Servername must have “Access this computer from
a network”, “logon locally”, and “logon as a batch job”. Verify there is no Domain
or local policy that overrides these settings. (Note: Both accounts are created
with these rights by default during the IIS installation)

Minimum required file system permissions

KwikTag works with the default Windows Server 2003 installed permissions.
Default Windows 2003 permissions are already more secure than previous default
Windows permissions, but if advanced security is required, see the KwikTag Security
section (16.2) for further security measures.

Internet Information Services 6.0 requirements

Minimum Required IIS Components
O Application Server [Details]
Application Server Console
ASP.NET
Enable network COM+ access
Internet Information Services (IIS) [Details]
Common Files
FTP (only if using FTP Scan device)
Internet Information Services Manager
World Wide Web Service [Details]
O Active Server Pages
O World Wide Web Service

ooono

ooono

Minimum Required IIS Configuration
O Disable session state
O Anonymous access only

SOL Server requirements

O SQL Server 2005 Standard (32-bit only, unless the SQL server is separate from
other KwikTag servers)

O Mixed Mode authentication required

O SQL Auth User Account with the following permissions

O Member of the System Administrators Role
O Database Access — master database (public role needed)
O Database Access — model database (public role needed)
0 Database Access - msdb database (public role needed)
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O Supported SQL Collations

O SQL_Latinl_General_CP1_CI_AS

O Latinl_General _CI_AS
O French_CI_AS

Service Pack Requirements

O Windows Server 2003 Service Pack 2

O SQL Server 2005 Service Pack 2
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